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Asn-1 5122+ Yodedl (Computer Fundamental)

1.4 uwRay

LR shygesll anw

1.3 shyers st
LY SRl USIRL

L4 [HAw A [Fold 2ism)
1.5 elddr i Alsedz
9.9 As2AAL USIRL

1.¢  Aealfdl uRay

1.9 vy

W Yol s W il yoaeid w3Raid vidg wd . el el aalll
WLl Aonqal W2 ye: A 8. uel ald [Fartdl daml s sdl ey,
aURtoratl Al 511 sl €l b oflat St Ao, del dd, st sl 1 sidearciell
5241 W2 812+l Gualal s2al % 2@ AP dl $rere2, ildalsH WAL adldHl
Gualal 530 aitadl oA A [mae) dldl velsl Aad) ad @ duer wilel ual 530 ad
8 led slwyery Rael dlul aar wd 2 Al

UL SRR Vs MERLd Aol

2R+ A PR 2, 51 Axt olsla 2y el A12dy d-l wed At
d<ly 2avial 210 8. A dd, COMPUTER ¥12d C-Commonly, O-Oriented,
M-Machine, P-Purposely, U-Used For, T-Technical & E-Educational, R-Research
Ad) 63 sty D2y -y Ad Baemi 2 Asdareal Gualor W2 quld W
2 SR g sl AsIU QY 9did Aot WAHIGL L LY UM A 28 el YEL €S
¥, Qw2 Gualousdl walell suRdl 4y a-l Gux uiuL 53 2 Sue-lla uledlg
Fausl 52 8. Gualotsal gt 2uuami 2uda . Hdldl Gu wBul saL 12 see
ALs5U USIRA 2l U] 3d O W axg DA gl g1 ARAA A4D
wsi, . v

Maa — wBul — ol

INPUT ~ PROCESS ~ OUTPUT

C AR A shwgeRal wdldl sma sl e gel-gel e sl (Input
Device)l Gualol L 8, it sudldl Anad 1S yel el Pl 21sl-) Output
Device ~il Guulol 21y 8.



el aagi-0d wuel 8.

o MY
o YLLALSS
¢ AU
¢ AAS

o [asau-laal
o yRiadld L sl AL
o el B

C 3 slygeRd el

[ v 24l Main Memory |

‘ Wledl 214 20 24l Yelr

HeRa u3us s (CPU )
Central Processing Unit

auldilas 24 df lsu
I[H‘i?t@l R AT Arithmatic &
Control Unit Logic Unit.

" da/Holy, A5
Input/Output system

: BUgl-1 sayer ezl
1.3.4 Ry WS Blsu (Central Processing Unit)
Were UUs 2leM slaed 41y oA, vidlal % sy A wd © dal
WAL 2iote iy B . wery ulus s Hoy 2Rl M9 6. \
(1) v wyla (Main Memory) :-
Yoy [l 32 Al Mdldll e sanmi 2ud 8. wudl wdldl Gur Ay
UL 62 A Gl sl Gur lsd B, wdldl Gua uBa sral sliyer
AUl GRalosdl iRl Wlsdcumi widd Bl 2Ad . ol
Houed A1 Gualol ol wsiy.
() (o 2l gy Andd Ml Aot 52 8 21 Q uldl Gur B £2 6,
(i) 2449l 5121616 1Ll Hie BH 5121901 Gualal 02 lal.dn sz ulbul
B3I SIHAAG ARIAR] Hie Yo WAl Gualal 2 8.
(i) MuRA Gu ulut sul ote A oly 215 GuR Hiscianmi 2ud ., [HolH 54
GUR Hlsadl udal 2udl sl you Bl waedari 2ud o.



Gv) Hdldl ur @ wudeld wan suddid el d 20t al-i e wond sdaml
A 9. pilal WM uel Y AL o Aagarl U ©.
oo e Riala s1eeR ollel R ual uRiddl ¢ld 6. % 32t ur wikdl sal
A gla Aay oL o el allel @4 (Secondary Memory) Mi e »ud 6.
allel 2yl ual wun s dl CPU 0l ucigt ut uRla Add Asouddl vlu 8.
A A Hlel ool 32t atlel @l GuR Al ¢ld 8. i UR d-l GUR

e UL sadl @3 ud QR o e ML dladl pid 6.

() wisalid 14 a4 2As4 (Arithmatic & Logic Unit )
2L BsHA $5Hl ALU dly 2ol 2ud 6. 2 lsual yeued gel yel
opall2l i wuelld, st wd . HAal s (Input Device)wiel wildl
Aaeal olle d dldl Guz duRiMs UBAL s HE »isoURld df 2isHM
Wsganil 2 8. vidlal Gualatsdl gl sl 2uddl el gEL sl
AR ARvimel s usl vsARid-db HsH gl % sl 2 O, '

(8) [eam 2454 (Control Unit)
Fraister SLsM AL - weel yoacd el el wlsHl Gur [astel uviard, sil
53 .[udnel 2054 slvgeai BOSS (¢lt) ddly ad & d Hudldl Gur ulbul
sl sl sl A Wi ogeingel sl 2k Ul O, wHIR, Gualolsdl Wil
WA %32 @l i d Fda 25 g 208 8. wdldl daedos
At GUR WAL 530 A Fol 2Ll GUR Hlsd ©. 1M Ll (eaeL 2isy
W s9 s 4l URd, geL el AsHA Uz wucuj, A AU siERd
oirtaclld, s [Madstel 2154 53 6.

(¥) Fda-Felu %4 (Input/Output Unit )
Qlu\{,azm o8l %8 Miledl Biva s W2 %L el F-iclu 25414l Gualol A
3 Y, ol MG, dise U, €D, DVD, sdldl dlrs, U glssa a9, d
o A slepel Widl Gualolsdi odiaal w2 el et Gl sisu-l
Gualol i @ B %, wiler, Birer adld it 493+l [ordar wal ¢d ugl
CRIRIR
1.3.2 . RAsusw-ll ulFadil
29l A1y A wdl Ul s e @l (Main Memory) 214 oLl 3yl
(Secondary Memory)Hi 21 8. U=d, 21l g sl sweR aAlssy usiR+ll isusaldl
yei-l GUAloL 52 6. % 3 wuudl Awel AdsiRMl e 214 ulttarl Gualol 5321
lal. d o Ad shge wfedl ur wdul »aal Wd-dl due 42ifl (Binary)
yealirl 23l 52 0. Wfl Adatg 53 usi Adl Al Al sulediA ofle (Bit)
50 6. B e 4 (0 viadl 215 (1) Gl k. 2us oflenl Aed el (Byte) adly
ol 2ud 6.
a1 udl Nger Wifsd)l g1 vi8l (Decimal) @3uyl 2l lal. aiR
SR wledl g5 dvidl (Binary) a3uni o dne ak © ddl Al a2 »ls el
dy Asuserdl %32 ud 8. )
Asitseidl uBul w2 vids ueala-dl GW&OL Y B, FH e weddl ©.
(i) BCD (Binary Coded Decimal)
(i) EBCDIC (Extended Binary Coded Decimal Interchange Code)
Gii) ASCH (American Standard Code forInformation Interchange)
(iv) * Unicode (Universal Code)



2L wefidl U4 ASCIT 4 Unicode Helint A4l ag wAlid 8. ASCII Horot
Uels s wadl &R ¢ ofleni AAeaH] A 6. UAS vis AL E WD Al 553
Rall (Ailbds 2a3unl ) A58l sl 2udd O eld. ASCII 4ot A <l 2isil sU, B
M 95 A58l sl Ul 8. QURoUE, SY A4l 55 1 DAL 3] 20d 6 v
d % @3uHl d-ll AAS AU 20 .

Unicode 1 sial Wuld adl ol Astiszeill uealizisi-l 218 8. Unicode weli
oAl seieua-l eumizi-e »1&R) 4214 6. Unicode l way 214l Unicode
10 M52l deet Hi R vidl edl 214 deg Unicode 1.0, %dlss 2008
Ul [Asaaail 2ue] yrslanl youd o el girl Asisel sl and 6@
(1) UTF (Unicode Transformation Format )

- ()  UCS (Univeisal Character Set )

1Y 51421 USIRY

.69 511221 Gualol WMIRL Al UsIRL r[lzl UHIRL 9.

A uilus slye: (Digital Computer) ‘

B 2734 513922 (Analog Computer)

C (M8 slyeR (Hybrid Computer)

(A) Ay 3111@22 (Digital Computer)

Slowed awi,az Yo HdldlA visui 3l 51 52 8. 2is 2uudl deve (dlglt)
a2} A2 ). 1 dwz Guz sl s2eiRA digital a1} dovaimi 209
6. il 31%3,22 HEldA 1214l (Binary) usaladi 324 © @i ol wudl o
AUl e FUARD WA B, Bl GU a0l WBHL 53 wsi B,

(B) 243U 51¥422 (Analog Computer) . |
setedlol sl el el Acll GuR 514 52 8. B Y, o UAlE, dludIA,
SAUMIAL 012 il s132R AL WA AL 513 sl el 23U swyerHl
Gualat oy Frebial uBaiMi sl »ud 8. el 2l RausAIl wul
el WA A4y dluHi o 2l 8. d o Fd, Sl A3 GUR
sl {Wlsdl 2 9.

(C) s sl (Hybrid computer)
flwed 24 A-idlol slyger-il vol-l qaeil-l au-ay s Bigl shwyer
(Hydrid Computer) +fl 224-11 s2al 2 8. Biay slvwgerui 2l-idl ezl
53U dal dlwed slggell AlsALS dl-ARVLALAL AHAA ALY 8. HasledLA-
sl yealadl el Ml Wi Bsl fvwe: Gudloll as ud.

LR shwedl dae sl aldd 2dar wsr e usel .

(A) sl e (e slyer)

B) M-l slwye:

(C) HASFH shwyer

(D) YU sl

(A) udsl sivyes _
WA 522 CPU o1 wiessl WRRR ©. Adluas wissl e ¢-olle WS4l
WRAR Alu Yuaq eq. aoll, 2 ¢-elle Ay AAed g 7 Hed, Au A5 o wwd
cofle ag ud o, dsdl ad © vudl uBuL 530wy B yeals ¢-olle sl
WA (1A el 9.



(C)

(D)

Zilog Z¢0, Intel ¢0¢0 i MC $¢0O¢

w UgRAAL S22 el R wiaal PC ddly ugL wlaman 2d 6.
el S22+ Guallal e Ad Al 4e1-A1URMNL, BB 3 uul Al
wol . AalRls Al ugl i USRML SRR ol HOL B, Al PSS
A= A 201 U dsarl 20 9. Auslu (legys), wat AN, A (Personal
Digital Assistant ) 2 Ugl idl WsR+ SRR gt wd 8.

Al siaye:

Szl Geanl uHA Hlal olaldl qeidla sl sl Hi2 valn As-dd
slrager-l Gualol 0L Al UR UHA Fell 1Y 3 e el sl
ad v vl Agedad w3z el e, Ml shzal Geowd adl -l
SlaeR B HsL SR dA AHFH 542 azldl fel-l sy 8.
AGH slwger ,

UGB e B ay aHdl dRladl SR 8. WAt dd, Hla g,
dlzeulall] At wHIRl SRl AdBIR) sRAL ASHEH dul HEldlAL e
5201 LAl W5RAL S+l Gualol wid ©. Jaels AGEH syl MEDHA,
SPERRY, DEC add il asidel aid . 3 ¥, 2ed 2u2aet Adl 2 Al
Sz gL Al A el alkd 46l (2led 2uRae sl 2y 8. €35
aflva v ABAFY shwer Al Add sl B

YU Sy2R ' | | |

YU S12R AL UM HosoL R wed ¥ ollog elan SR 5l G @l
4R1adl Ager 8. vl el el aedl e © wdl SRR Wil

. Gur WL sa W2 DLsld seueal sl WANRAL Gualal wd ©. iR

C-DAC 22l 4131 U (PARAM)-iHe, Yur Slyer oirtiadini 2Uuy 8.

QU Fdg wa Foly As)

szl Ml sivd saL W2 Fda 2isHl-l (Input Unit ) L Gualol A 8.
QUROUE, S92 wudl Wl ur w54 dd Guulolsdl umar 29 sl (oly
A5l (Output Unit) L Gualal 52 6. 2udl, dl Fan-Fol 254 (Input-Output
Unit ) (9l [aoid 2l 532 '

L.4.4 A el (Input Device)

L4

(Al 2l 4RL slgerul Hfd) e 53 ast 8. v Al SR A1 el R
e €l 8. vial el 12 wael 8.

(A)
(B)
©
(D)
(E)
(F)
(G)
(H)
M
6)

ARSI

HIGA

dlgse Un

Ay LS

25 ol

w¥lse Wy AR (OMR)
AsA 35 AR (OCR)

Yo dls 65 3s2R AR (MICR)
YLl 5I

2%, 3\



(A) f-oi$

(B)

2au5la-2

S-o1l L sy dldl sl s LSt a5 AUt ALt 8, 6§ )
vld 2 3[R0t QWERTY 21y 1622 %d) ey o, Sl-6ilEAL slel eugy
QWERTY 4 adell ¢lu 8. 60§ Gur et 1d 10 41 2udell
9 it ol d4 Aoy el 4 quon -6ld woL iz ual 9 ) 4 Hi o-
¢ Ao Z, F1 to Fir, tllse, s-gld uee, ¥, ols 2, 212z, delle, s-us
Aol Sl Anidel A V. i Guid 32 (Cursor) 4 3244l 12 AR 21)-4]
uel wudel €y Q.

ey ¢

2u5(-3

WG sladl seed] Alssu qwdl GuR 3] ws1y A USIRY, A 9. HIGU
WlS-2loL kA (Pointing Device) dl} ual vl 119 6. HGAAL HegH)
SR A dal Ve e saml, Sl S w5 v
A=l 260 sedar Qe view sl W el Gualol 4l 8. ALY, e,
UG- GUR A izt widal slu B, <16l Uzl serl) weeell Guz SR TR
3L 51 8. U1 wusll uggetl ot Hegell 255 wsiReL Sl B4 & -
AU A vilag Fan sl s9 wsi B, Weieioi WG vk Jor4lu, idreie)
Al wudel ¢ly 8. ¥ ywidl GUR $Radl 21 AUl $3 6. A g vyl
4Bis Az W AU 6. 2 Bty Broviey 512 Hlsd & F yorod shyer
Al el 2lssu Bausi 329 & 210 By ooniu »lls HUGA ULl HA 8.
BHL o+l ooy HIGAUY ddrl Al WRvidl W2 Ao BRei) Guyloy 4y
6. il WG deiadl w3 Sy © U, BBy did ela 9. '



(C)

als2uA

Fram Computer Daslitop Bnoyelopedia
@ 1988 Tha Computyr Languags Co. lno,

s (a-¥

et welL vls Wil -t 8. B ueed] 24l Gur sudal Al viexll
2T UR seLs 530 As1 6. dlselenl ISR ollaln el el 8, % sl
oA\eS AL 8. il ALl weedl 90 ale uetd Wl 53 2l Gu caldl
Wi 8. ctgeladl weedl skl Mala adaisd us ok 8. 34 3,CAD
(Computer Aided Design) Hl GualaLsdl digedri-l Heedl Ay 24 GUR %
(ot el Wb ©

ola s

- Agla-u
Ay s uel s WSLoL b 8. BHL A uHRl oy (pusie) e d-dl
Gualor w . A dd slaersl el el ™l L e ofld wlsHl
GualoL 2 B, ol sl Gur s wl (Als) wddl i B, B+ Heeel)
ARY2UIHL Y2, st 3 Fabg 530 as O, A o4 285 B i
AR $32 €l A [BAHL 20100 WA, % W . Ulgre sar Ad- 6l 52,
gl dl dd Al 3 Ralai weg diad w.



(E) 2soi& :

susla-s

osolletrll GualoL yel shyer-l vie ™dl ™aAl W2 i 6. L sl Guae)
dRg 2s old wddl ¢ld 8. % 2sl-U Ui g Y 6.
2500d uel HIGY B, % AL B U, Al VIRL 30 ALl elaslHL GualoL W2

ol U 6. Vi QUL 250lld GUR ol MRl 2nddl eld 8. B+l Heesl)
el el sl 530 ws B, Aualumi Ulg-er-l sandas 112 aselladl Guylol
STON Y |

(F) -2 ésa ws Ak (OMR) -
dril U WML 191 GUR B AlssAU (Ml seMl 2l 81y &-1 aial 12
OMR-). GualoL 2d 8. il Ak 218 vilvil B ¢ld 8. Bl 2ie 51010 slma
$AHL 21U, 8. 2L S19L01 vl 530 Ll A8 12 otrlidlil 20d 9. B+ GuR
AssA woul ud ¥ edlalell Mot sA wsi 8.
ols el el gll @ waleds ulal Ao © i el erl sl gl
Beil HIS ARALH 2AL USIRAL ALHAAL GualoL 52 6.

(G) »dlsa 33322 W2 (OCR)
L AL Wal 51900 GuR-L 321 3 53 A wdldl & 8 s AR S0, uR+lL
WAL 25 sl olte 22l vide Rl WA AR 2d B, A4 A
wgl @ d (Fuely dati 2ud 8. 2l et L oui 2Rl 3+ s
IS

(H) ®ds ¢-5 33s2e2 s (MICR)
Nodls e 3522 L3r) GUUlOL URL AHRA el 5L HR2 WY 9. el
GulaL ueL B8l glrl A% eRly A5) Gu-ll M8l Giaal w2 ay . As
GUR B AS oR 24 ofloy Wiled) el slu © d vuA UsR- auéle[l SR
$ld 8 2 dd Qi W2 MICR -l Gualal sa 29 8.

augla-o



(1) wudsleln : _ _
WSsLslA uRl 215 Fda Ak 8. 2 k-l Heedl v Wl s
kel ] Asi B, Ui, A Alssudl vo 2l ld 8. SR B, €3
bl 261l GRUIRRL el el €1 ©. dell, Heupsil gl e d 2kl
sl dsedls W 8. ey, DA a9 sl ddly ua aayi wud .
R, o181 L GualoL MRl el s2aL Al sl Gualal (ol s
adly Ay 6. ‘

augla - ¢

2l R aud Adglust g 8. sal, sz siuel Al gl -claidal
£ wiovlal uasL 4 ¥ dl s asl % wrA as il ddl well Heedl
Aozl Gulol 530 s ¥ B B gIRL BUBY Al AR 8L s 53
sl
(J) 2

23 U WA Wl sl 59 fdl Anaa eeau a8, s Gualowl
@ & sl Aonadl w2 Hiat wioelldl sl 2l ) Alss oo srelixdl Sl
3. w0l gl QIR L Al 32 oirude 285 gL uel sl 53 ws ©. 2
Al A oilanl el Wl B 7 Gl 8. ugl, all viE: AR vuddl <l

9. 2l uee ol &6 awowat ual wdl A el sz 3 A sl 52wl ©.

LUR (el 2uadl (Output device)

R s urel sfed) Ada oie A Gur WUl sul oie A wold A Y sl
C a2 ot g (ol plsl Al Gualol w8, @ A wus 8. (
A) il :

(B) Bi-ex

(C) wler

(D) w12

(A) widleR :

U4RL € H stdlon Wl HHleR B vl of Hgeete, (ol e 89, Hi-lleR DERFEL I

2ig2 Qi 2162 siEL Gualol 533 WdldlA shuged GuR eald 8. [ARyl e
sdd sl SeR gl 2udd MR FuldRa 530 Wiflex Gur ealddig 6.

11
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W22 2481 W51 oslal Hal &

(1) CRT (Cathode Ray Tube)
() LCD (Liquid Crystal Display)
(3) Projection Display

(1)

()

(3)

CRT (Cathode Ray Tube)

CRT 2l »uyel 8ui Gualoim ddl 2l B o 2\s4 8

CRT #l-{l22 2410 &l.dl. ol vjol o 18] dsyy ayoiril Gualol iy @ 39 CRT
(3eils 2 2get) ddld wovaisi 241 §.CRT 4l §Asel- dleisil Glmm ULy 69,
B e L qudl e 52 @ Al o4 G 52 B

LCD (Liquid Crystal Display) '

il GUUloL U UuH aRUWHL S ) gd) A QliRolE, le[law
2L v, el W2l s19El 2 B % Ani Gl Al vt 206 %32 W .
2 CRTHL aik Gl aBd-l %32 W 8. s94 w§ s2al CRT | %oy
Ul Bred-l Gualol scimi »0d 8. -l Gualal Aualudl saHL 2 6.
Ugsa- dug

Al WSl A eled 2l gell WA WSH dud A Guule Wy 8

2l e Az A1 Aladdl QU @ A Al Heed) Hg %94 Gof 4L

2ud 8. vl dud e AR 3 wewelHl Hlsdl ofdlddl HI2 2l ¢

 [reR

12 uR 2 Rl salaari 20d 8 A vew awd WS o Qla 8. s,
Rl S0 R dal W12 [Bireredl Gualol Ay 8. el ot oid« Bier olal
40 . rere aollsre -l soruail ovsy et Al eoryadl opatay wwisl iy
8. Jeels [Rre wsiarl Birar sa2 2a {3 08 AL 519100 GUR oryal 1S
ugl auriy 8. A il 2slele ao ez Qi ©

(i) Ba-dloL 25-lalen: §¥is2 Vs, Am-S-lse [z

P15z Biear 3 2y uderll 2sddle wwel sl 83 6. Rui s GuR
Aot-t-l Hegall Suldl Fell VSR, crg, 253A4 V. 2L B WA V. Wi
A FAd, 51010 i dld a2 Dol Gl 8. w1l -l %Sﬂ&a el
3lsa Gl ¥ $dsdls Ruorral Meedl Bire s 2ud O,

(ii) A WAL 2L AHHR Vs, 2 A5

UL 2R Al Birer 3 2ivl AsR v il s ol 6. WAL,
gle HAlsu Bieer 3 dlell seed]l waR oild 8. e Vs Birerd opeleil
oiofl gly ¢,



(iii) B-dla su : Rlua Vs, s Vs, Uy
Biletl Hoaol 2Us AnAAL (e deg ol ak 8. B4 Y, aais Birer e il
8. U, ASH B vl e 218 o Ayl ol O, 2, U e 2y
o w5 o uHYML ol O,
dl, 24l ald 4 Breul wlal uudl el gel esdlalao-l . 2 »iaol
A2k 25Ul AU d2als UHIR quRldl w2l DA waisl .
@ e %A B2 (Dot Matrix Printer)
() S22 Bi-2(Inkjet Printer)
(i) A»= (e ( Laser Printer)
(iv) 1 (e (Line Printer) ,
(v)  MF (22 (Multi Function Printer)
@ e A M2k (Dot Matrix Printer)
L35 AsUL [rer sl As . B 254 DMP dy il wud 6. i Wsiel

BireR &R o1l Hi2 $l2 Al Gualol 53 6. [Big - Are-il Heeell Ul HHaR o1

8. Al o d- sl ALl Brer dly 2ol 2id. 8. 20 Bl wd $aise
Barer-l Aol e . 5101 3, 24t Brer, &l Heedl 51010 UR 2N B4R
Guand 8.01r2 38 i sl azd Dol 2udell ¢ld 8. i (2 vt AN i
Aell B, ug, eflogt Birzrel ARvIHR0ME 24 Ue-D eorusinAl opeiaiL Aol ¢ld 6.

wusla-10

(ii) S-s%2 Bi-ex : (Inkjet Printer)

AL UL B2’ Yllse girl oiddl Al So1 GUR 255 UHIML 2sid 53
il 8. 2L UsRAL Birel wude A S:se Bieeadl eflai i . 2 fi-er-u
el agetail <12 A 53l W €l B, ug ArR Blrer sl ool lu 8.
2L WAL Brreal sl 2 «urll doofl Al Gualor i 8. B 512800 a1y Bluval
2ud 8. 4t soof) vuell U 1y dl dui e ) eudl wsid B. uRd A wala 8.

ausla - 14

(iii) 4Ao: (22 (Laser Printer)

21 Bieaz L sorusiar scrll opetadt il el sl asen G2 gld 6. i [irer-d)
A9 Ul Al S¥se wsiRAl BeeRldl wd 8. 2l QU Bel @) u-d st
Yag-ll Heedl w1aR) GuAnddHl 2Ud 8. 1L S0 WA MRl HI2 2R L Gudlol

13
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2y 9. L 2R a1 Ad B3l Bedlor 52 8. 20 B2 s Bifeul § o) uo
Wil (B2 530 ad 8. 2unl qeL sa [fve: A 8. uig, v Bia-l Bad vy 22
3, Sl2 A5 Brer A Srsge Birer sl auR Q.

augla-12

(iv) e+ B-22 (Line Printer)

A (-2 uRl 12 Ad s Breerell st neuliq 22 8. uig sle Hl wouial A well
A 25 o auial vl 8. dell, A ey Al quid 8. vuar Biwe s MRzl
200 Al il Yoo ar Y ol ad 8. sle A su Baver 2 s B
s o usiR- 2silellw Aed ¥ $¥lse Birar-ll 2s-lelovell si sl QS il
QuRLdl st ol e Gow B la . B+ needl s Birz R %58 usiy
8 2 sl AR AU AL B. dguRid AL 510100 YR Alss 22 A1l B
Wl gly 8. Fedl 110 $L3alml AL Q. Asell Ay Asa Anaar d fBeer w2
oL sto1h a2 s1of s1o10 YA s B, B WsRA B2 WAl Sl 9.

sl -13

(v) %l dsun (-2 (MFP)

W UsIRAL Bir2R sl ol Sr5%2 wadl dn Biwer oid meﬂ 86 As ) sidusuly
AR 51 52 Q. wig, WA WA AME 354, IRA& B Wt el AU S Bls
b ool idy adl slu 8. dell, o A s srdi ay 51%1 ¥2d Multi Function
Printer (MFP) afl% alaviami 2ud 8. '



(c)

(D)

gl -4
wileR

Wz 3 Bran nag g als Gl q 8. el eedll uel ulysa

WiB2Y2 519101 GUR A wstd B, AU Ad, HE sl 3 s s BwR
Mirz 53l M2 wil2wl GUalol saMl 20 8. wledl 52 A8 wler wid {4
wler - ada AR 9. EAAL s, sk R oAl e bz ol
w2+ GualoL AU 8. 21, S1U3 GUR SlSH siual M2 gH el Gualal
2y Q. g1 lleMl 51101 3 susel g MU d-il GUR e9LUsL SAUMHL 14
i .

w4 ). T e

2152 uel A5 (ol (output) b B, AL A 2uuew BRHL U 38R AR
% wsell Gualol i 8. Adl % wsieel ws-Al Gualal sl wa 8.
253+ Guulol vtaws Aold, adlam adid Aicinagy 2 wd 8.

susla-au

9.5 818dR M AsedR

3 wusl A8 nhA w1 gl 50 vdeid] wblel day sauger-u oflfis eyl
a1dd sqal 20 6. g, Hler, f-oif, e, Wwer, s1i-Gs 4ol R, B
2l S 1l 9l udg, Wl ¥ e wsdl el d Ws2dR s B, el

wdslkilse af, yFis 0L lkey 4ol FH kit Ad suddR % 513 sAas.

WAL 2zl avlal ey 8,

15



.94 siddr

spweRe ofiftts el e1ddR ddly 2o 2ud 6. BHL SAsdlsa dal e el
A s AWl v [l 24 FolH -l amde ay 8.

(A) 2U3L A2nes Au-ll(Secondary Stoxage DCV]CC)

1 8ld dks

sl Qs

3 sl¥lse ks (CD) N

¥ dwed adada das (DVD)

Y A ESE] ‘ ;

(B) x=2e uldys 2154 (CPU)

1 wus (Processor)

vy Ay

(€) i A4l

1 [Md9 Al (Input Device) _ 7

R [0l uml (Output Device) 4 :
(A) *lwt 2i3ugs wa-d (Secondary Storage Device)

e g s ddl} 532341 RAM (Random Access Memory) <l Guula 2y,
€9, TR o0er dAanes dafly elf -das , seldl-fas, A4, L4, A g1 90l
AL Ay &

(i) w18 s -

2L 25 ollel A2t s A4 © B L 241U ol -1@1 cul Yl vl asia 8. 2
Jas dolldedl e cuddl €la V. B iy fesell B ot sl sl el
GualaL sal % sufedlal dadat 829 d Hledld 2udl drs GuR ysarni 20d 8, 2umi
25 Qs el el uRg sl Wwie el 6 R Azl oilsumi sl 1.l viy 53¢
el 9. il sl A sa-l sl vot ay 21U 8. UL AHLH] ¥O GBl
Ul 150 GB YAl dlrs udl 8. 21 dasl %4 3500 rpm (Rotation Per
Minute) ol *idld 9200 rpm Y- el 6. 2L 623 drsdl GuR a1 {13 oy
iy vl s 8. e1d Qs wdldl iz dlal cmcu W12 A8 A2 &3 2udel ely
6. 20l dlag Ase 27, 2sui aduidd] Gy

Spindle

Platters -

Readfwrite ... . ..
heads

Cagn

Controller ' ,-" A h
Data cache

2l -15 sl uye



(ii) sabdl Sxs

L A s uldoll él%s HR1Ag, WiRdl s A1aReIHI oY vg\btglz{ AA s WY ¢, Bl vie
219¢ sl 21512 adasiz e Bl ¢l 8. YR, UL 42U Al Gualol oyl
42l 26U 8. 51280 3, 2l 5l AR H3AL HRAAA] 21 AR WAL HiBH] RIS
ol 28 B, seldl f2sll 2iae sl &Mdl 1.3 Mb (Mega byte) ddl 4.¥% MB
A gl 8. dal d-l oillds sy Wy S dul 3.0 U sHw: Gl B

215 ‘—‘1'9

(iii) CD- shse Sias

CD 2 i<t youdl el yafid danes dzs 6. DAL disne szcuv[l &4dl SUo
MBl Hifld 940 MB -l €lu 6. w3td-l MUl CDL Guala Feis o)
dal (el Aatganl sanl vuadl sdl. ulg, ¢d Gualatsal Wil “Wisdl CDui
vl AdaiSel As aouel) ofley arouilell ¢ S u . CDHil Wkl aiaal
dal &vdl M2 CD-Rom Drive dal CD-writer ¥l Ald-l-l Gualol e 8. CD-
"R 2 Al uskl CD &8 Bui g avigt avll wsi ©. qdl R oAl Hdae
Recordable vldl a1d 8. uig 2l CDML Hiol A8 o avtd @vll 51 8. del vigr-)
WERA o0 530 avll asg 4l s CD-RW AAui Rl o0 s avll
w514 8. il RWHL Hddol Re-writable 21l 2 6. 22d ¥, 3¢ aull asiy 2la
24 . WHIY CD 212d ¥ Bt ol ¥ Als2dR 4ladl CD 3l Wst CD- Rom
. x2d ¥ CD- Read Only Memory ¥ @il Hia aill asi .

(iv) DVD (Digital Versatile/Video Disk) ’ ‘
QAL 2L A G A s axdl dRAddl s © BHL 28 2wl e Audl as ©.
SR d % e w2 dall ael A0l Gualomi Al i 6. i Ad, s Q-
AAS sal-l &AL ¥.9 GBHl lu 8. '

(v) dq s1654 :

Urt LS4 WRL 2oL YOI, ws uu[&m A s Ak B, F Ul s vl GuR
SRl w51y 9. H2 o, dn U g15a a1y 2] 209 . Al AL v o -l
A audl 12¢ MB L Hidld 2 GB ydl-l ¢l 8. ey Jd, 2L g18e USB
(Universal Serial Bus) ulé Guz @ducl st . :

2usla -1¢
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C(B) weua ul3us vlsu (CPU) :

24t (39, 240u8L [tz 22l 210G 530 Ysur 12 udg HYou Byl 20 wsIR)
(agl 2l 584

() yva ¥ld ( Main Memory)

: Yoy @yl v sl Fae el uel Haa Hlsdld ulbun sl e Aaeard
Sl B, ¥ —URGE, A dleL B GuR adl FoB el uR Hisadld ¢ld
©. RAM (Random Access Memory)¥l v 23yl dZly Gualoi dawy .
Yeyu Rl W5kl RAM el 6. % -l wasl .
q dfaslla (DRAM) Dynamic RAM
3 21 (SRAM) Static RAM
3 A4l 2faslle (SDRAM) Synchronous Dynamic RAM)

(1) faglla RAM (Dynamic Random Access Memory)
211 U5+l RAM PC (Personal Computer)i duaidi 2ud . alaella
yador dl AAdl B Add die sl G U3 8.
U, sAML L 20 Al AN Al o WA O, 24 skl RAM W9
el elu 6. :

(R) =l RAM (Static Random Access Memory)
21 U5R-L RAM DRAM $cl wxiil ay 33Ul vt 2tledl ewwdloyd (Valatile)
i 6. Udd, Al ay 4o aBdsll %32 ud ©. 24, 2L RAM UHIRIHL Ay, Wl
8. 2idla el Hadst ¥4 DRAM Al B3 diRAR diew sl usdl L.

(3) amsHl auldslla RAM (Synchronous. Dynamic Random Access Memory)
2L, RAM gl 25 %id-dl DRAM 6 % sl vet 33Ul ©.

(%) oladl uusdl alidlle RAM (Double Data Rate Syncronous Dynamic RAM)
21l RAM 48l 2$ %ld-l SD-RAM 6. uig, SDRAM sl oladl siledl uwr
25 o AHA UBAL 53 AF ©. 2 RAM Slérl AHAHL vet o wAlld 9.

(C©) ¢ wanil .
2=, AL el el Fada-Fiold il eudg i 9. @+l [asdarR 2al
2Rl U8 530 Y i,

.9 AlsedR

AlsedR ¥ o+ oflosl Aol ULl WM 3 512+ UL L UBIUAL AR
13 url vl 61l d vIvR ser-l it 8. piR wlddR 2 R sél ws.
il AR AR s B9 d o A Wgedr doR elddR s 8. dl 2udl, ylsedR
(A9l otz Al s302, Huacd Alsedadl usiRl 2 wael 6. Alsad-At wsiRl (@l
AL 4é Gudl AHD AslA.

z&::ac‘lz
1 J ff
A2 Hlsddr sl 5ot
lFedr Algedr
1 |
d J 1) 1)
s vl 2lrudeR card A || Ry sl
(Operating L ICTRIER] Guuloll CIERTN
System) Algedz Alsed

sl -1¢ yigedu UsKRl



(i) Meen wised
Aren vled sl Alew. Alkey Alg2dr Hi2ieol slayeqd sidd sal dal d-f
stledidl arRal Ml Asedr ¢l 8. B4 ¥ 0.8.(Operating System),5utdeR;
Sreauller adld i USRAL WF2AR 6. ) phige s w
(a) was veald (Operating System)
&2 Alzes @) 20 dl, wall sl AgedR-Al W 8. ¥ A A4 euddz
stllad 53 Gualotsdl 2l Aadar dar sl Gu UL sami 3 1k
AAS 5L Hee3zu Ald . Aelldaq Alszdrd Aeidal 12 wel U oL Alem
%33 9. UL GURid s41 WlaLMA 5413 Aeiaal, Gualatsdln ¥33) At oAl 2y, eis
Qs GUR 2dd el el WAL dal s1Sel, Haun 539 adlR, ecls v
e Al Al Al wael o,
(1) DOS
() Unix
(3) Wingows ¢x
(¥) OS/R
(W) Linux
(8) Mac .
(®) Windows XP
(¢) Windows CE
(¢) Windows Vista
(10) Windows ME i
21 YL Rrey el el Su-lall giRl ct-iladii uda 8, Rl yuud ussise,
8 &2, IBM, HP adly su-flafl-l 2pude aid 6. 1 sufladl o Gualosdll
%3[Raldl 3w, el el waasl A w3 Rauldl Y s Ude 52 8.
(b) aud22 24 eunwil (Translator & Languages)
el Wl yedls G sau-ll eusmaH avidel ¢ld 8. B3 ¥ COBOL
(Commonly Business Oriented Language) , Fortran, C++, Pascal , Java
Q2 el el Gualol w-a Gualstsdl sl ¢la 8. @R, Freudl
Aol dodarel Gualol sl el 8. AL WA sy’ o HSSUAAR
A9 Ay Al ol 3uidRd sl »ud 8. Al 3UidRet adal WlouHd
Lo 52 UAM 5¢ 8. 2lAASR Bled ldl WA B 215 U] dbidel wansa
o{loo GNL 3UIARA 52 8. 211 GURid deels a-udex avla WA + Asiidls]
dal geigel W oo sald (Assemble)srald 514 53 8. Youd Al
USIRAL 2L-uder oflal 1A €.
(1) AR EETCH)
() suldar
3)  Serller
(i) sad i
fleadp Alsedr As Wseda oot Agedn W wlsald s 53 9. Meadz Hed
ol Algad+l Fraui A s s2UR Als2dR L ¥ b 4LS wlsedR 32190 el sl
52, Hiold Sl ol Al o3 [Rald Horer 18 Uu-R Ws2ARA {13AdR dd e
wd 8.
(iii) 2lwll3an wisedr
Aellboi Alsedl Gualal sl W AS AlssA wsRAL sl w32 wsdl el
SLSURL MBI B AHIL 218U sl W1Rldl €ld A 21 AlgedRAl Guallal 53 A 8.



Aelboart Algedal youcd o st W 8
(a) Aavwa Nd Gudll Alseds
el As2ARAL GUALAL ANl T s O, B WAl GUALAL s 2
S A5 USRAL suet ¥ spasadl w3 Wl el Al o, puan Ws2dr User
Friendly Software sSalMi Ud . U ¥, AG1A%AL A4 stdl, usd duial,
AR s s 52q, WE AUIR sral AR W2 el Wig2ARAL GuAlaL 53
s 8. Yedis el Agedz A1 wd 8. z
o . ad wiARflo AlsedR
Word Star
Word Perfect
MS-Word
o 32 Anelflu-dsele
Lotus-9-3-3
MS-Excel -
o JaL AdwA-e
Clipper
Dbase
Foxbase
Foxpro
MS-Access
Oracle
SQL Server
DB
Sybase :
o 3 Ay el d
Page Maker - ‘ '
Coral Draw '
Ventura
Photoshop
o Uproud |
" MS-Powerpoint
o Sraaq2 e
Microsoft Internet Explorer
Netscape Navigator
Mozila Firebox
Opera
(b) [agh sl w2-u Ag2dR (Utility Software)
GUR WS+ Ag2dR-) Guylor 530 Hlawedetl sidl 530 wsiy @ i, %aals '
sl sl s2a1 2 Yeeus RN Als2d-) Gualol sal W 8. B Utility
Software d¥13 2N 20d 3. Hidl Alg2d-Al GUULaL- sL HI> ALSSU
USIRAL st ot Agetardl 33 WY 8. eLd. Anivirus Software, Network

Monitoring Software, Network Resource Management <913 il ll!rR'iL
Ag2dR . ‘ bl



q.¢  ealfa 1l uRay

Aeabd wiugl aerdl ciriul oy sl €l oy Aed Bui vl s dr ol
AR 2l sl el © d o Ad, sl Azabul vs sy oyl slwer wd
AR gL (Wired) 12idl o1k (Wireless) olsidd ¢l &, 2uord, sl dafdd d2a
2l Sreande ©. Srea-deml vual Hall erl d2abdl uye elu 8. dead-u Gualowel agu
ol dtodl Hadl asia 9. @ A usel 8.

U

Aalal 2oL

Aeabl sl vl Al 835 SgeR a2l adadl asd ©. €8 shwyeR
W2 AU AL AlAe qutaal Uidl Al elo. ws BeeR<l Gualol Heaky
Wl 218 sdi adl sy sA ud 9. rlaqém Aslddl s eifis
2l A S RAoiy el

el Aol

el A el el Al Aeadnl Hwmell Gualami ad ws 8. d o Ad 28
slagerl dat da Hedl ol sl GW&OLHL A sl 9.

sl e .

ALl AMURL Gudlol ad) el Buasivier W2l sma TR
(asa-ludl

GuR sl 13 © ¥ widldld Ador Aeab-l s ¢ at&q 9. dell, Gualor scil
Wil Mkl s sl a4 shwer U dadl wd 8. Roll, ok A8 s
sl valell 2ud dl ugt, 2Rl Hildl s udl «ell.

VUSRS AUR HIMH (MAN)

dzad 2 Yol AR HLM §. Bl 93 YEL el UL YR 8d Guulausdl
HEAA 2u-A wadel 53 a 9.

1.¢.4 "easd adlisaw

1

dlsa AL deas (LAN)
s Bellendl Rrairdl 2ie 8al sz olsdl 3 dead ad dd dlsa
AU Aead adly 2qlamani 2ud .

C s, AL A2ds (WAN)

el el AL A UBAML piidel Auyer Aidi deabd WAN sl 2id
©. @ b Rl Aan w2, [R5z 28 AU Aeas vaal Srerte usL 2s
widl % Uiy dead duwll s,
Jalleled 21R0ut deas (MAN)
dlse AAUL Aead sl wHeEl Hlel vd ads A dead sdl i

oflolllys upanl wudal slayerq Alsadl dead MAN sedii 2ud 6.
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MWEH -3 JAC L) -‘ljé‘\"l (Trouble Shooting) ¥t Resorce Sharing

2.4 g0d giloidl ufRkay
2.2 How to use DVD/CD/ROM and Floppy (CD/DVD i Floppy il Guylol)
2.3 Burning DVD/CD
R.¥ Taking data on and from aflash drive, pen drive (Flash Drive i1 Pen
' Drive il Gualay )
2.4 Using Data and resources from LAN (LAN -l Guxlal & Add Printer ihl
LAN (Resource Sharing) )

.S Usmg FTP for uploading and downloading data from Internet. (uploading

i cmd downloadmg by FTP )

2.9 Infmmatlon on Scanner and Scanner Softwares/ configuration. (How to
use scanner) '

.9 g6 Ylat-l ulay

52 alR(bd uval W2 Al el %el Wl da d-t Grdd, sid ¢lg %33
€9. 2404l 2UUBL MR AW EL AURLAHL 25 AlerlAl Gualol 5302 el2) yig, sl
At Al 2usl ey [otdar el oetdl Feg slaex [ ddl elfar a4
Alged (gl el lol.del ol slugeaui Sl M A+ GeHd ol A g2 s2al
Rl 4l vt il ez Troubleshooting d313 Alopidii »id ¢

(1) Troubleshooting Tools

2R Ml el el AlsedeAl Guuldl iy ©.%HIHL }acus ¥4 % W-dles (Scandisk),
s sellu (Disk Cleanup) a9l 9.211 it Alg2d+Al o) MUl Gudlol saelm
d dl sy A AU ol wsin O Rar dsotiee g
(Defragment Drive) {lzed el (System Restore) il Gualal $30 sty .21
(Rcid vl gall oty Alg2dz @ slaex Al Wyl al 4 dal eyl Guasy
9.94 ¥ Spybot, Hijak this, Sysintenals, Autoruns, Process Exploer, Rootkitrevealer
G R TR :

L ol U al&acl%ﬂ Al Ug, sy etéclvu sl dsdls el dl 3dl Ad ey
dl ¥4 Slsex v, @M ¥ deisiRL, dldlg sl awlld oL el 4 d o Jd
Ul el seAl 235 adgys dal daell durRild slayer-l sat eiddul dsdls
9. el ndla o,

s12ul 545 oyl vl 6 d W2l w0 edl ©.POST (Power-On-Self-Test)
U SRl [Anals WG sUHL 2id U d Post -l Gualal 5304 2y iy
©9.POST. 5323 i H2letotdl e1ddR vl Gararyds dl uig d sid 53 8 % «idl
d AUl .20 Rdid el gel werl-l sid sl el Guell wal F-d Al il
Ad st 52 8 % Adl d wwell asy ©.CPU N &l slayers 3 usq vtaal
aafad Ad s34 53¢ Al drll U 635 BUARL Uvid 6ld ual 4ol aael eld
8.67142 ((tda) i 262y ((Holw) Al slorgeld, Hvu 5181 Al 1l Yo Qly
9.9l Hie Al Fafid Ad Alssa yealded]l s s2al Al



(2) Troubleshooting Virus

S22 oLl 2 SIRRNHL aluR ey el wusld. AU SR8 H8L SR

el ud) o ©.aelair ciuAdl s1RRIAR s1ea-dl adgys -l A4 sy d usiHl

s .. bedls AR slyer il aride oit uss wu ©.24s Waus (Application)

Al fes Gudl e e d B.aad W ke GuR el dl uel wg Al U

ASAL AN @BRIHL AR FAUAER ¢l 8.

Al Wl Al U Gwd A Antivirus ds2dR ©.Antivirus F2dR Al Gudldl

s e A oleiRell vilddt aluAdl otuidl s @ H2IeU0] AURA AU AY S

sellfl dl2s, CD »tadl Internet <l el 2diddl ¢ld . Antivirus AlgedHl

Norton Antivirus, AVG Software, Macfee Antivirus qalR-l UM WY 9.

(3) Troubleshooting O.S (Opertaing System)

U 8oL Hlre i weL del otul $IReNAR Al del wid 9.983 & voiidl syl -l

2L 4l vaal dui 581R udl dul %l Gualolsdl qlrl 2lal WlgadR -l Gualal smi

wd k%l mé wdld U800 AlreH yriold + el dl el uRdlal ke s

oledls AP © AL oY UL AY 6.

U200 AReHA YA A H2 Gualorsdll slsust s1RRUR Al siesel i A3l

Ao A oolg alevlaal sl Ws2del Gualal el Algalgl W2 vluRdoL

A2 Yot A Gl iy oL Arzs 2] slayer- Adldal Hidd, Hecy AlgedR & %l

2 613 dl qHlY AlsdRA AR U UF @ i otul o AlgdR S SRl oib A U

6.

(¥) slrweand Ay adl Bdl A5l wnRul.

Ul Bl oL SIRR0UR SRR Al L At Ab U, AMirl s AHIA SR80 ¥

slousl 25(Hse sied A HRuddl e 11w 1l d yeaed A wusl sél asi.

(A) sy dlayasl ueladl . 8l

(B) %l ‘fwyadl Hufid saL sly A4 B4 5 CVT ( Comtant Voltage
Transformer) 3 UPS (Uninterruptable Power Suppiy) %l el Gualaiil
dardl gl v di sl wRiell ela.

(©)  WRIARHL vRiell Gemidl gl

(D Hurelld i sls vRiell Gesidl ela.

(E) RAM #i vRiell Geaiel gl

(F) sl gel el cudld dryrad YR wsdl SMPS i vl Geotdl Sl

%l QUL Gl o AU BRI Q1A AW e9di slyeR auc@, o g eld ol uel

2wl duid sl sl

e ol dl A8 Ag e1fdR vy ¢y dl det 5138 vl el wud Gell Ay glu g
o1 ;

o Adl A0 d SLddR sl duig AL,

o ol dl atRi-l A4 Al Slu dl A et dwdl Al

2 GURAd 5172R iy udi oy (Beep) L 2aly 2Ud 6.drl Gul UL 58 AR

6 dal sl 8 d Hel s B %) SR Ay udi 2l o oy ARl dl syw HRICR

© wal %l 25 sl AR oflu sl dl ofludl dvaiAl AR du s wsE o,
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.3 CD/DVD i1 Floppy il GualoL.

CD/DVD ¥ Floppy -l Gualol Hifsdl 2iats 2 s2aumi 20 6. 21 635 RaSumial
wledl dal e A wglittl Guala 530 s, .
1.l uem dselu GuR el My Computer GUR soidd sells 53,

2. B S AR Smgzaul 23d) ol) e SUMHI A, dEGWRid gelll 24
CD/DVD i 285l uat gul.

J LTI T T | Vit e e
i [P

ey Local i, (c1) S P LT S DPE YO8 )
g o5kl _voLs e
.?Qa (e ik 4
s .
Flgure -1

3. ol quiell 46 s18a / sl Sl ¥ auA s Hidlel Sl dl sdlvl ¥ CD/

~ DVD -l 21854 GuR e sells ).

¥, o'dd A8 s15a iyt 57l 6za9dL gla dl 2 d $L6c~2{ru uL&Sslvt GUR sold
scls .

WAl dd A8 s1dd 3 fleR 511{1 5391 Hidldl 8ld dl @ d $154 GUR zLeSa sdls
53 copy [isen Guz sells s3L. :

. o Rl Sl SIS AAE KU HIB D W e A 53
‘Rl AS2 sells 53 paste [Asey GuR sells 53l ude sl s18d quRL
sbayeHi sl wal.

Audio/Video CD/DVD -l. GuxaL.
% dil Audio ¥ Video CD/DVD «il Gualol 5cll ¢l dl did) CD/DVD A §i6aui
sl wugfui salel wsl Play audio CD [ised wie 530 OK oizrt sdls Sl

- 3R, Audio ¥ Vedio s15¢ Play 2.

Figure-2



qgd Audio % Vedio $194 Play 5l W2 dil start>programs>Accessories>
Entertainment>Window Media Player iU~ 531, 17 Aui File A open sdls

3| aniZl Audio ¥ Video $15¢ ldse sl Media player i Audio ¥ Video 5194
Play 2. i '

Figure-3

2.3 Burning CD/DVD

716 uel CD a4l DVD uR 22l e (write) s34 M2 ol Yaoirl R
a4 UsA.

q. 2l WHH R Y2521\ GuR-L Nero start smart 2S5l Guz o sals s
2. gl odio yorer ¢d od o, [useu %S usal’d 44 CD 3 DVD Rllds2

53l el el [sen %R usdl Fal k QA4 CD ¥ 080 CD. 2Asl 516 U8y
Y1+l 321 M2 Data [Bseuni Make Data Disk ddse s34, : _ :

Figure-1 .
3. vl Figure ¥l sttt W48l Add elert GWR scdlls s

Figure-:
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¥. ¥ Sl select Files and Folders (el goumict 4. 218\e]l % File ¥ Folders
CD i sl s2a1 S29dl €la d 215 wedl 31s Ndse s Add oled sells 53,

Ul 25 53l QR File ¥ Folder Aldse s:al CTRL 4l 4 Gualol 53] sisia.

Figure-3

U ed A5 dim siden Aldse sul uedl 2id Finished ol2- sclls 530, AU Sl
- udie sRell dMIH §1Sey iq glesal dlre tuugl, 2 Guzm gl e Yarol
el Al oudl 234 ¥ ol o ouad, :

Figure-¥

§. RAUE Next olet W2 sdls 53,
¢l Disk Name $les¥i CD o ~is 2U4) €l.d. Emp-Data, 213 6114l 23¢ Disk
Space -il Guulat $3 s 12 Allow Files to be added later (multisession

disc) (A5e4 yaie 53 Burn oler w2 sels 53U



Figure- 'l{
¢. U 5dL CD ol i 2l 29l wa vid vl eldieu 11,%'0{ Burn Process
Completed Successfully =il ¥A% stdlagl. 21l OK ete-t sefls 5.

- ]

Mum-.p-numlm
Cacliing of Hlos started
Caching of hloz complelod
Buin process slailed al 10w (1.500 KB/1)

1 -uuz{m:du.u-i s

ﬁﬁi?“ﬁﬁ?f_

Figure-3

Wiarpbgg Fiovaus
Planes oebil
I :
T e
EV0EE P Gk g ety il

BT S0 VK Gl o e s Soriisun
00 e

Figure-9

€. i Next ole sels $cii CD MUY 6l 2idd 2iA ded Bxit ole 5dls
5l CD write 2ci-l WBuL yd aal.



Ky prieowt find st soccamluly

20 FM  Caching ol lilas compleled
Buin process startod al 10x {1,500 KB/2)
1,500 1:6574)

Figure-¢

-

¥ Flash Drive 2, Pen Drive il GT-BQDL.

0N vyl erecn das el %l o€l daudy %S 2w eld. DVD 3 CD ¥
Floppy disk 2% d Flash Drive ¥ Pen Drive il Gulol il 3Rl 2ile s2al
4 A vl GURId d el 58, casl dw-, s Gualol 53 wsiu &c[l storage Device
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3.9 Installing New Software and Removal

Al dHIRL 3lwi,az=u Install 526l 516 Wlawst-l GuAlol <4 6l wld dl dd |
3 Qaugeniell g 53 w8l eld. dHIRL Qwiazma[l Nero ¥ CD/DVD

A82 533 WM © A Uninstall sl ¢l dl @2 531
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254 - ¥ oke WEzu (Best Practice)

¥4 ulRay

¥.2  Patches

¥.3 % s¢lv 2y (Disk Cleanup)
¥.¥  Antivirus Software (U2 $3ql.
¥.u ¥ ds (Scandisk)

¥.5  o{s2u (Backup)

¥.4  uRuy

Sl piu-g-32 vidl Wl W el

Sl 2z il AopeRley st s2a 1 Al sl s uerll Aol udia d wel
Al w3 RuUA A AL u-g32 AL wsld V.ol R Al visRlEl el
A B .21 GURid Sals A52AR gl Guulal 5307 adl Hudldl 4 drs Guz e
oflecl a8l esl.duy ciot uHa Yl wadl usl ol

¥.2  Patches,Upgrades,Versions = A+l dll Install $24l.

Gualotsdl @ el 2udloy leeHel Guulol sl el d aluas anedl ud o2
Q sull gl A AHA Al dddl ls2dr 3 B wluRdlo ke 2u-g-de
UMl Hee3w i d-l Gudlal sl W 8.

Patches U8l 25 »iicley Alg2ar-l cliol .841 und uud 2uRlol Alees-l su-dl
gL »u2 Aol AlaeHd Mee3y udy Patch o Guuel s2ami wud O Patch Hde
2280y ez~ yReu auiRal, lu2 ol fleen-l seleddl atiRelqu Ul dRl
ssueiell olnadl dul Gualotsdl iRl dradiell Gualol 3L astd dst e Gl
. 5311 214 B 21l Patch Hl2l oldl grarAzAl Hieell @ d su-l -l deuse GuR
sl 2id 6.

Upgrades ¥ 4lel ool €35 ~iirll W2l WS2AR WS ANRAHL Ud 9.2 w8l s
o1l Ws2AR o B.Gudlotsal WA 523 8.4 el 812 Gewes Su-lsi
sl 20dd ¢ld dl d Upgrade [l Heedl y2u SQCLLHL%{LQ 6. Upgrade il Hddot
% el Al 3UIARA s el WA B,

Version 2\ 21§ %ic-ll Alg2aR-0l Al 209t dY el asid 981 A H wHd
QA Adl gl eIR W S 8.0 o A9 adlgedul ueL ol 3 vl el
A g2 590 el 15292 etrttaarrtl »ud 8.8 Version ¢l A0l 2A1d 684
¥ Ms-Windows Qﬂu?{‘-l Version 3.1 &d.QlRele Ms-Windows 3.1, Win-
dows €U 9.

Updates M2 % A 5230 o %id yv2r2 Gurall As A ab d-it el aadral Slu
S0 wda 2kl d NS ws S, '

57



58

i G T A e A o SR i Lol S TR ) (N B
h e i o Ot iR

el ¥ |
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¥.3 {l¢ sdl--»1u (Disk Cleanup)

s GUR B qeuRlll sl sloal Qld At S1EL Avia W2 dag sl 2y, -] (aey
Rl Guylal wy &

Dlisk Claasmog | More Opticms |

| _— e PO San use Disk Cleanue to freeas us to O KO of diske Spscm
I RS = T =B “

Filsz to daletes:

| EWW1LWJ&WM%WM&HWWW'WLJ |

| it
| S0 [SR) S mtslag films for U Eaitmr ol ooy ] 0

| T catal rMmounl of cishk speacs wou gair: LB s T

i rilesims Files wona Fraysers il dael Froam o A
=y Thnr.-s FII-:-,. Sfe Nob perraaris ety rernosesa e tll y-:yu
Sristy e Mecyesle Him

[T Fiiaa

L S S _"'-i’_-‘,é_.';_—.'é;:fl _..“.I

gl - 2 ,
A A grededl dowrll s, Nauasa - olani wda sisdh quirid dloy
$LE56l A3 s1ud W12 s1 ivial W2 o selleay ) epazenl Guylol 53] ASIY
09215 Alss AnY 144 530 %) 2L el GuElol s 2 dl s Gu3 514l
slell a2l A5l wourd Aadl sty 8.0 % Sweadl sileadl wel quidl ws

t

¥.%¥ - Antivirus Software - [HalBid Update 24l

UARA 4IRL AHIRL $122 8LEAR dal A52dR A YAk Avial 1l Al 20 22
A Antivirys Software 8.usg, % 6o el il AURY w2312 2] oflog] Mo
SIR1 AR R 9,48 AR AgedR AsaR Sye i wilid 530 da udl A
Al Adl AU AlgRA wpel gy S.dell v Algedr )l Gwies Fudl vl
AUHRL WA, 122 YU AUAL AR zﬂ&adz L 3R3RL sl ¢l 0.7
Update -l 2a3usi yofl 248 €.



3z el 2iial Updates <L A0l asia 8.Fabid wel s-dldiur Alg2dn
Update $3cti 284 d sea Y AmaL W2l U0 Wl 8

¥ 3% s (Scandisk)

et sl Hetaol Qasd As sacll Byt s2ell dell i 8. Feells AR Al Hals A
wlzsles el 518 % ol Sl SRR e valds dd U e 5101 AY$
el @ das Bu2 ld 8.4 atalad Ad sy sldl «ell 2 gRllaR dlyudiel
quez ga el wadl adar Jrs A gl s sRel drsl Sl8 ML o118l
i .01 & oo GuR Ml il wel wsiell 3 ot Bt Jrs-ll weed] ol 530
st .8 swge Q elel GuR Hudldl avll asal .

¥.5 olsuu (Backup)

w14l ogielaL 1o ¥ wugl Sevgeui 2iuel mbsdl-l e 53 ol el ulg
Yaells AR a5 SRR 2id) A3 sl Hdldl el gl adl2) edlal.aa yedls
slel B0 3R wlan el udg divt wna sl Wl 9% A B.ddl slodl
dl Qas GuR 2oul AL WY B.Q 2udl Wdldl-l elsau (Backup) 48 Usld 8.2
Qa5 Guell st Ul ooun Aol st ©.6suu asertl il wdldld efley sl
o), 2ionedl Bl 1y A5 <L GualaL 59 o3 d MdldlA ol sl U
waal ool 565 AAS SReALAL HEHHAL A8 ASA ©.

(1)  duldad grl dsn

ALsiu WL ofEL el WH2aR+] UeL el gl 8.6L.. DBMS (Database Managerment
System) -t Algadz-l Heedl ARl 281 a3 uml Aate 53 wsE O.dl vl
il ofHL 2ELEL e 210 dld Bl 2d 8. 211 321619 )l uBlL Gy ds
o514 B8l Al M2 ¥ & DBMS it 215293 Hi Backup «ll el €14 8.61.d.Oracle
2) 25 DBMS .43 uel BACKUP | [seu suciai »ud .

() Blsxu g4 (Backup Tool)

Asuiy el Gualal s uBl (UL re aR) HEIdAL olspu A wAsl
O . Windows U221 22 1 A5 38 U e §.FH] diR 58 Wl
Alsotu Adl O, dal sl 22d b sl slesaul ¥ aloe sl sl ddl .4 wruAg
RIS
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L A dd Slsuun uedl 2R (Rsetore) “Aeei-ll ARl GuylaL 304 yd Aud]
AsA 8. ;

(3) kel ga ( Restore Too}) |

WA G52ty garl Guallol 59 Widldl olley 51) & Asid Buig wudl A dsay
s WA wiedl 3 Ad Aqad) sy, Asuy gl W23 s siuard vs
52y $18elll ddld urld ©.a0m W12 TraR gl GUAloL SRl 2Ud 8. bl
U2 A Glsay gadl Gualat s3] ) o % WA ABUAHL S22 gL WL 3

" Asay ldd Wl DR A B A W Risen s A 9.3ReR ga gl

A3 AUl ¥ ol dlsmy s3g sl sl dell, usllotell suselniel sty
slodld ueL 2l 59 asy o,

Backup or Restore v
‘You can back up files and settings, or restore them from a previous backup.

What do you want to do?

{_% Back up files and settings

O Restore files ahd selings

| < Back “_‘ Meut » ] ]H Cant.:el—]‘
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[dlos vildall dal ol 51

R-dosell odsctllull  *

5.4.1, 524 U4

5.4.2 deudl eumy GARaAL Ao
543 AdAUT2AA WA AR
5.4.4 cidlvL i el olsasla
AouHL 2Ude Seurl GualaL -
$L%Sét WA e RY, i

5.6.1 A=y als%t'tcﬂzz
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51 Hdld L

$122423 A 5¢ AUAHL U L Arl Gualor 57l s el €l Aellos osud Sy
wdlsanl 0 8 2R -l A8 Aulds ygla us el 21 8. Ads ugll Med w1z
i Gullolsal-l 422 12 s 18233 . 3 % 6iAA A0l 53 2UUG Nb 2R . GULloLsl

- LA A piladl 20Re el Al Qell Alds UgRid s Gudloisdl-y »iRa

L8R BURAHL 3ULdR Sl 11 D, Acller T e18ArL 2R U Guadlotsal waew o1k Aal
2430 3UidR sl QU B,

U 24 U5 25 Ugil el iR+ 2le s UgRA su1ms s S22y,
(Command Line Inteerface) ¥ 254l flad241z (CLR) ddl3 »larvieii IERIRCTR
Al2duR s ets gl Gualotsdl- Hei ot 20290 4 Avidl Yidl s, Uig,
%4 FH YA UsiR-l 2ets Ugldl Aical eoll A A Guadlotsal viet o 2ol 4
2 48l A4 A 2Alets ugli- Gualol s34 gy,

el A Ul 204 51 53141 201et GUR R ¥ 3RULA ARl HaRBd
ol e, Adl o A Rdlos sl Aers UgRnl 26 Gu Jesdu A D, IREEDRIE)
I ar3Retetl 1wl e sl S1ell Ul (e alBse Big) %gcmu 2l

LR

2014 GUR QR0 12 s2cll Al 21uell w3RAL Al 1AL Ul 201 GUR vjeel]
Al 121, dell o A [Amilos sl eds ygRai sl oszRaic aefl sl vieel 2]
UsL 9L, &w el 3Rt Q1 Aell 1656 ol 5307 215602 (Taskbar) Hi 2158+
AU AV wsH V. ¥ w3RUL uHA s30ef] Wl usla B, A4 ol weL 53] s 6,

52 Guulasdl w2l SveadSa (User Interface) :

DYULS Ul Aleds Wl vtiacell 208, HGu A Gudlol s33 Wi 21de
AN ol ALLOL BUR LG G121 %S dvil 2iHe s3] Al B Uyl Gualovsdl M-l 228 S
8L AR i 3L ot B, il wLREA] GUBLAL D233 F<ll WBsa ALEAAAH] vl
Al HA 8. YU UsR+] Alets UgQH] GUD Guadlol doteidl v o o4l &,
UG QUL AL Tk Al %L Ll dlell el Guallol A3 e HHId) %el e
Sl 8. Aell o Ao 215 qvict (Bs sl vieldt 213 At A it (Bas sl viefaer vaL
%EL %L €14 S 4l MIGUAE AR oot g (Red) 2iuami 20 8, Al Gualat 241+,
ASAUS GUR 3 1A (251d) saL 1S seM] 20 B

5.3 (Al wilean d oil saL :

1R S8 Bl Al Aell3annl 2He S AU B, AR AL AR Al
[Axdlosil viletenml 20A &, Qo Alets ugldl 2s s3dL At Aelld a4l sidad 26 43
6. el ief el A F ot g o UMY A sl AR [l vilell w8l 9. el RRML
BULUSL (Aot wAiel 5307 et weRAH] Hserrll 3Ruid uel Gledl 4 a3 . aril R

gk [Adloy aufee oliRul Mgl oo »al elexdl 24Qe i B, |

3lofl euegel senn Minimize (Ardlosn el 50N Yyt el ysd)) ver

A3 2Dvua B, ol 2l olen ‘Maximize / Restore (lrdloset yal 22030,
/ @r&bﬁ il RaRIE Q udan- R atqc&) o2 1 Bl 8, 29 Heal

oz [ ] Close (Rivdon ol 524)) elert a3 2lovuy & &,




|| Minimize (R il 519 4aal wicizel 1sdl) oleet golldii 0

9, QU ellFud Wsau dlon RRAIRME oldiddlg, ol sUA §5d 2R$6UUL % Gl 8.
o3 21R56URHL U o el GUR (Fts sl 20d 8, iR 32 AnellFust [Axdlo
Sl aCu 3UHL ULl 201D B,

{ Maximize /Restore (R=lna ’-,LkL 243U [ R M&Rv[l ERA

a udal-ll @[?mt aladl) sle- solleali A §, Al Al 2uS2e sirul el el a2
[l 53] ©ladl d otiadl Rl vicuiR-l REQAi A udall Ruldxi dlad

st sa1l A B Qe 2ufed, oMl Mgl g a2 A sled el
AL A B, Yia
| Sld dl o eolladl

[Aedosnl yel 230 viledtd, s1af sl pUd 8. e 212 oML sl bt_lzak CEDREIEIC]
CEERSLIRY|| o QELCTRTERIC R )

2 A 21fed oul well sugA a2 Hdd sed

1| Close (Ru-dlos it 521) bl2-t Eotletl dicUR-AL et Rsd o s3]
21 8. |

54 [0 asaedl (Wondows Setting)

[Qdosui 8ol ot Rl Hodl dlaiel d e3s Ylarznl aiRl ail sl
o3RuL udl €U B, A GURLc 28 % S22 g sl AR 5 Gualol sdl glael],
257l or3Ratc wd [Qxdosedl Nsaslall el o3Ruld Gled wd 8. dl e »iud
ol [Alak ollsaefallmi 3l A yail auiRl 530 wsld d AS5Y.

5.4.1 $2lau44 (Control Panels)
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5916 Ul GuR o i Start >> Control Panel Guz B s3cmi »0d & Aol
2L(A-1 LAl [A=3os v &,

i

I
i | 5 semch ; | Feldars

vibkdan
8 s0irds and Audio Devices e
HE Spheadt)
Easystam
wib TASkBAr and Start Manu
#itser Accounis

Ph‘Jne and Mﬁclem Optons
"M‘{aFw &) Opnons

wugld-2

579l el Accessibility Options, Add Hardware, Add or Remove Pro-
grams, Administrative Tools, Date and Time, Display, Folder Options, Fonts,
Game Controllers, Internet Options, Keyboard, Mail, Mouse, Netwprk Con-
nections, Phone and Modem Optiond, Power Options, Printers and Faxes,
Regional and Language Options, Scanners and Cameras, Scheduled Tasks,
Sounds and Audio Devices, Speech, System, Taskbar and Start Menu dal User
Account -l [asedl vual 9. w[EUL 2UUEL p2LAL eldLl A3t [Qsedl (AN die vy
qadly). ;
Add Harware [Aseurl Gulor it 2d o ol diil s12ul +d ¢lddr
GRR 69, U % UL U D, LA A g S92 1L D13 @ Hlgul dlael] RSl
A3 52U 2 B, AR A AUAD Aal $LEAA AW AU B, w1 o33 gL Brudle 52
8.

Add or Remove Programs (2seu-l Gualol Al dd [A-doui S-uld sl
WIAAA £ 59 HIR A B, A4s 32ells dvid A=l sul 531 1Y S-ude s3en @ d
ABALHR2 URL AU B, T

Administrative [Aseu-)l GuyloL Component Services, Computer Man-
agement, Data Sources (ODBC), Event Viewer, Local Security Policy, Per-
formance 211 Services i YHIRL AL 524l Hté 114 . ODBC 4 iRl a8 wuRuiel)
% 53U A B,

Date and Time [Qs¢u-l Gualol dHiL augazv{l e v dal AHY, seddl
Hle Ay 9. _

- Display [Rseul Guallol JrAHL YAIL dHIRL $dL HI2 dld 9. AL e
Themes, Desktop, Screen Saver Appearance, Setting %l [Qseilui YL drlL
KUY, _

UH UL A AL 81 ¥ 52l U Aneel dail d-dl Gualol ) gell %

0L~ 9. ,



5.4.2 rudl (il GHRandl dd :
Regional and Langugage Optlons [sey-l Gualoy s3euell [ sl yed) i),
Rurdlos A%l 2tets ugRi HA B Al Gualol s3c izl odselell 53 usia d. Fuk 2Aud)

[Adlos sl s wglan raidlail s1d s2a1 %12 Regiorial and Language Options
[Qseuni odl 1A naud-dl 25l 20d 8,

4 Regional Optlons“:l- :
| Stendaouds and lonmats

|
This option affects how some prograrms formal numbears, cunencies, deles. |
and time

L=
: | Select an item to rnalch its preferances. or click Custainize 1o choose your own | |

| forrna
|

Samples
Numbet:
Currency!

Time:

Short cete

Long cletes:

Sl R TR TR

Tahelp services provide vou with local information. such a8 news and
weaathar, Galec:your plasant Iocnltcm -

|Incha

w4ld-3
driell Languages oie-t (55 s2c1ell 12 uxdlel 2614 B 1A .

| Langquages
5 ana inaut langue i'\
To view ar change the languages ancl methods yau can use to enter text, click B
Delails I
e
alll [ Details P
; =SS

? Bt { :
A Bupplamental langusge suppr
Most lsnguagas eve installed by dataull. To mslall additional languages, | -
| select e applopriate chack hox balow. :
" J

g o apma S e

i = ’
Ok i [ Canual J[ Apply J

susld-4
[l Install files for complex script and right-to-left languages (m—
cluding Thai) < wie sal uelel Apply vz soitddl Sl el Feell wal cwwi) °
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4l 82 d dHIRL ng,aw SAlel s2UM] A B, 24 512 WS d1R am\a,az% 6iy $31A
s31ell vldal Hi2el 20390 21 B 9 RAsRA o out»ub& ngaw drele UL 8. 25

avid g s suf ueloll r[lv), HHIRLAL LA Rl HA 6D

¢ Texlservices and input snguages

| Details.

Siippale |nrnhl I gyus ‘r[m SN -
Mosl |angudges are installed [y telaull. To install additional languages,

[etalle, |

_:' To view ot changethe Ianguages and methods you can usé 1o enterlext click . |

selectihs appropriate check oy lielow,

(] lnstill files for complax script and ight-toslelt languagss (ncluding Thai)

| [ ingtuu flee {of East Asian Imnfjusges

[

s 24(d-5
" (841 Details...

Cresfaacilt inpuut [an g 6 =" 3
Salact one of the |nslal|>=cd input Ianguages to use when you staut wout
computar, N

It IkS el g fiibvnnsses ' 1L
¢ Salactthe tel\zlc.tis thtyon wenl for 2seh in ol langlme e & hiswe inthe |
| theAcld and Ramove Bullons 1o nmduw this list,

m = nth h (Unilnd "'lnlss) |
-QEL Handwnting Recagnilion l
it = Drawing Pad ¥
' ’ = Writs Arywhare
|
|

1 = Wriling Ped
Keyhaaid
LU e
{? Speech Recognrilian

8

; }‘ il e e

(gl LJQ’.'L:}.]Q&E'Q':] [ key é.'éiﬁ?ﬁi; """" il

. oedn (55 s8] WA w1l 241+ Rey ch ®.

st Llga

: a:ugfa.6

[y wui 56 58 ol daiR) N gl Gualam ¢ s Al uR

Steitaalil Uad] €lu 8. 8 U ol ol GAaA WL Add...
muglvh Bl A .
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" English (United States) dioil udiB tla-n sotiadl eldidd SINEREID]]
Gujarati A u2ie 5l 12 Ul 251 YA 8.

3 215(d-8
Keyboard layout / IME : 3 Gujarati Indic IME A wie sc (12 MR
UlAvA 69, _ !
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Inpt [angyage
Tﬁuara

205(d°9
2R Ok ¢i2+ oLl NIRRT GQQL&S 04 a9 3 12 53410 214 el
ARl AL .

’ D\_fault|nput|.:\nc1u4r]r~

| Select one of the installed input languagau 1o use when you startyour
cormputer

T P [T P Pt B P (ST E T T S (R Y IS P PP PR Y TP PP P TE A b e S
Enaglish {(IUnited States) - US i

|hstadlzd carvices - - e LR I
| Selectthe services thatyou want for each input language shown in the list, Use
I the Add and Remove buttons to' rodify this list

: |
| i o Wit Anvahiana : a

. \Whitlhey Pagl :
5 Keyvboard
- - uUs
'd'.'f" Speech Recagnition
Ciujarat
| ﬁg Kendaaared -
l + Gujarat lndieMET (V51]

12

- [Heterancas NP e S = = A 1w O l.

[ LenguegeBar. | [ KeySetings. |

i 4 s e e b o g

a»ug[a 10
o1 MRZAAHL 512 52l 1SR AR 5 SUNL YRS S A B AN WolR W

£ Al 112 Gur~ll 314l Language Bar...: oie-l gotiddl 1A uidl )l 2414 R qa &



[] Shaw the Language beaon the deskionp

U e Freee ey O EHE Hriad ks SEAY SR R ) e [

e i)

 ugld-11
2341 Show the Language bar on the desktop 29 Show additional Lan-
guage bar icons in the taskbar < Uale $4 Ok el2-t estidel {13 w8l taskbar Hi
Language bar icons Al 1A 8. UM oty 3 L AL oteelal v &, R taskbar
Q el A3 1A B ’

214{a-12
543 diadur 210 264 A4z (Wall papers and Screen Saver) :
op1l LAl 32U il A% Biotrl 3 ld i 2UuAL el MR CATRE )

Al osall 12 110101 S 211l A 1Al start >> Control Panel >> Display i sl
20 6, ax sl 02 wHd Aoy YA ©. ;

250Q-13

e Guarll 2A150-13 1+ Desktop 2oL Wie 53e ALY dlL AR wie sl GWR
Al Ao 1A B,
1 v Rsdedl weiel wiesll sl &l dl Background <l 2 2de
aidliell ot Gaig 531, uaisoll sadiedl d o & Rlot 3 Brudl A dlaiadiil 248, A o
Qou edl dL Apply tlert Bis s2eUHi A B



70

A GURidt dMiRL RsAY GuR My Document, My Computer, My Network
Places, Internet Explore oiciacdil 2113 & ¥ 2l sicieidl A Customize Desktop
orent [so1s sanll Aad] wsiu .

AR A ASuRL st 25 ana Yol s3cl ell, A4 443 Screen Saver sid 41y
8. Het Yrie Wl Aar{l waieall W2 start >> Control Panel >> Display 4i Screen
Saver < uig scuMi w1d 8, Ay sl AU Rl 4 8,

pl Brisen Gave

miittlas ET e resumo, panswand prstes

A prrnted

Tt mas il powi el s veve amiray. tick |
Frawe . ]

25la-14
L (Aol A4-316 ke ollsumiel] d3 Hel-uzie 24l Aaz-l waieoll s3] 919
61, 2045 24l AaRHl A+t Setting »dal slatell d-l uxieoll s2e1 12 Settings vent
(825 s2cUni 203 . 21 sul ued) 2814 Aeiel] 1R Rl W2 Preview elert Frs sacmi
A B’ R Jeet U vl ol 240 Ao vlidg § Aee Ay, Wait ) UL U] 218
691, A5 duid 2l A 1R Al A IR elell i Yl W d YA A 2yl

Yl 2l Ad-{l v A1¢ AL W2 On resume, password protect | uzs, s3a1n _
A D, |

5.4.4 Aidlvl 2 quasd asanlvil:

TR Rireu-ll il Aedl 44y gaRal i AR start >> Control Panel >>
Date and Time (5tis s2cuel] 12 uH1d-) R wa &

(|4 5 8
Ml 1 12 13

K]
Date & Time

7

e

9

i s

f:i Gurrant time 2she; India Standard Time

w4 ] | Ca_ru';;'el !

e A s WA i it

14 15 16 i7 ¥
18 19 20 21 22 23 24 . v
25 8 27 28 29 30 @y 2
' | 9: 13rszam [

w4ld-15




Quiell Date & Time uzie sl »Ud 8. 1 Q=i uieolll #i Date Hiell
Aol st &, Adl %A arf wal Aacl w51 9. AR olle ddlv wrie s3A Apply oter
(Bets srael RIRRHAL cidlvt ceellud. ddll o a2 e teadl €l dl sels dla el
GuR [Bas 50 selsll Al (Bota 2l a5 . AR el dddl A MFe 243 As= vl
oeddl Sld dl otedl AsU B,

Time Zone GuR (Fas 532l Uil 54 AHU Al 2UAaL gl A sl d 8. dall
& IR oleadl Gl ) oteell wal ASIU . Ay A eledal el &L Al &, 28 dA Qu-
316+ 122 6151 GUR [Bas 5909 it ule uHa ol uRigoll sl iR ofle i elctidet

(Al 52l GuR [Fas $3 Mt urie uHd ol walesll s34,
2030 vl wst B, ¥R 3RuLc HHdl $7ell vl wsiu B, viadl ol ye 3 usu @,

55  HAqeurui2udd Seudl Guall:

£35 Aell3ait ol deu (Help) Ag At HA B, £ Aelidaid Ul deu dy
i 2iadl YR %8l gl Al ua B, uig ua Gl d el ud-ll Hee Al §, 24
Al 1Rl 4 F1 £3s aeldalenl e €1, e Ag 1 o & Uil Wledl 2uadl
QU D, ¥ 3 Aell3awt-ll At R, ¥l 3 A3t version 24 -t e, s
oflog w1+l ellFuul Hadl AR YR 3 A Gualol dd wst d AeelHl Hes
g U 8. )

5.6 $104 A slesr [

5.6.1 RS0 Aselr : P
opl M1 1655 sUSe wadl Flesz ue g1 Rl argRatd Sld AR dHiR (Ao
AsAe3+) GUA9L 5361 W B, Aril W2 IR Uuy 2218 oles goilad, R ugdlell All
Programs GUR 1G4 2R ¢ el veldl A Higdl Accessories GUR G LR
asS %l viddl A wiell Windows Explorer GuR (s sl Rrdloy 250122 A 8.

I] New Office Uocutent
Fen Offfze Document

A P10 am ACcess ardd Eefaults

4 Indovss Catalng
a temet o % windons Update’

i 63 AWK e i I )
E Rzl v o

:ﬁ.‘a-]_rc,&mifsrl.m ‘sl kil ) G
o i) iy (¥ £ ST
iy Martieans (O s part
)P Irvipechor Fig Iecwny o e Program Compancbly Wizand
i ;gj LM TS ST T v s syachroree

] T SE a0 e v 4 8% Tour windows X

L Lt R E

- aul-16
UM GUR oidietl Wl st 1A 1l Aoy MR YA 6.

71



72

L Efit

- »%"

View Faw e
s =t ik

P b ’i

& Searth Folders | ‘\ﬁe\uvs v,

*x EL3Y: Floppy (A:)
" DHIREN (C1)
sw Local Disk (Cn)
L CD Ditive (1)
i Shared Documents

PRy (Al Hhclop's Docliments
DHIREN (C:)

Local Disk (D)

CO Drive (E:)
Shared Documents
i dbp's Documents
3 My Network Places

My Documents

# Recycle BIn
@i My Briefcase

2u4ld-17
[Ardlos L5l 6L c11oL 20 Qe DU . 316 OUYTL FUOLHL REAUHL A 1SR

QUL 2l SR el Slel 214d sUSeyle  wgl sdiaal A 8. dell vileg Wik
53 JSey/flesl il MR a1gl oell liogl st 20 8.

310fl ool oLl Bl Rael “+” 2uuRia sidld © ¥ gida/slesaui ) acm
A B, 2 AL AR PRt s D d) sAustd B, o+ Rl Gur Brus sacusi
A, AR Raudl 4+ < o16d Rl =’ Al A S P19 A ALEUELER 316fL tl19griy R
[Aqa 1z Rl 4L . Gure] wWglni My Computer +l 201 <’ cul & 3 My
Computer l:?&qa 330 Adidd 8. »4R My Documents «l 24014 4+ £l & 3 My
Documents i % 44 §1&R 244 8, ug AR Radd 43 elcide Al

[Fle Edt. View Favories Tools kel

2y
22y My Docu

# % DHIREN (C:)

& e Local Disk (D)

% CD Drive (E:)

Shared Documents

dbp's Documents

My Network Places

# Recycle Bin

#2 My Briefcase

Copy of 2-2:200418)
WEsrosiT- Wkl Dl St
by B 4

. ﬁ'ﬁ
e

=S |u|:JI e

1] My Documents

25(d-18



Gua-ll 241501 2R AS WA €A 3, a2 Floppy 4164 Gur (58 s3UML
A B, AR well ety Lol U sAMIHL AR S5 dal s Sl Al 1A .
a1l o Aad %amm aufl s S Wl A,

4 R ollw 913 vl Riedlos MsAeRAL %S ws1d B, Al W start teq GUR
WGl araall slore, et (Brts sreell 1A wdl A ya ©.

Open

Explore

Search.., .
Add to Winamp's Bookmark list
Enquieue in Winamp

Play in Winarp
Properties

Open Al Users
Explore All Users

24(a-19 ‘

211 . ddl Q'L wigll Explore l wigall saal 2uot R uHIRl (A3l
AR A D, ig 3 N2l § 3 3 v d ‘C:\Documents and Settings\dbp\Start

Menu’ §lerq, vllde o{dld &,

5.6.2 dl 515a A $1623 biladl, Ay Al WU HEEdL :

2101 AS o1t e B A saclRa vl srvtel ddly diid gl lmi 21
£les olad B, dl udell sl Rirdloi File Gur (Ris sacuell $156 A4 8.
Qutiell New Guz (Bas sauel viet A-ie) Folder (Bas sl g e A ©.

SR
o e OTREN ) 18 diel Fhoatip e

Za sy
| gxaat
| Bl booaie

| o4 B tmage
o Y Merereft Weaea Domer,
) '|I_F]M|f1ﬂ.k e Al

| 1) M osnlt R P Fresmtae

| Wl ﬂ( b i Loed DB i1 Teat Dommenl 1 u){ua

l: 207 aedl 4

b L TREe ()| A Wi med) e
‘  [elo A o stwed By ] pcronaik B weanees I
! &t bt Doltme I : i |
S“"l“!!s"f_ﬂilﬂ t.r 45 6 by e Pl 11y Copratesd rn-;-m]rcm |
[EEECEN .
£ My raeace

nu.-wwwwemmﬂdfnm .

u14(Q-20

73



..

| Fle Edt View Favorites To
: : Gy
L&) Bl
Back el e Beanchy | F

".;.-fj. fm'w | iy i S LN e
Fold"rﬁ ! iy i Mo

G Desktop

i 5 My Docurments

3 19 My Cotputer

4 3¥aFidppy (A1),

£ New Folder

i s DHIREN (C:)

i @ Local Disk (D)

i b CO Orive (E)

i § Shared Documertts
’ dbp Documents
i %2 My Network Places
" % Recycle Bin
g’l My Brlefcase

»4ld-21
eq UL L flesrd Uy v 20 & 8, 2] dla %3&%@ €1y A g slar
otritell ustd 8. 21 Ad File >> New igll #3R41d Al siasl 151z waie suell e
sl el s16e i asiu .
oflew Ak weL GuR vl 51 59 Wt B, Artt WS Rrdlos DsACRR+AL ¥4 o119
GUR G W2 e S WG Mg vlert [Ras saiell ANE A wa B,

3 Folder
E Shortcut

£ Bnefcaoe

. Bitmap Image

| B Microsoft Word Document

I8 Microsoft: Access Application V|ew R

18 Microsoft PowerPoint Presentation

T Adobe Photoshop Image

&) Text Document

| ) Winamp media fle Paste

) Microsoft: Excel Worksheet Paste Shortout
{1 Compressed (zipped) Folder

Arrange Icom B\/ i
Refresh

Properties

215(d-22
89 flerg U veaatdl Ao ASY. Ao RsArdlRHL ¥ Slesrd n C'tE.C'I.ClL:L
€l A9 w2is 531, ued) File A e oy2uiell (Beis 53\, detiell vddl A44iell Rename Gur
o (545 5.



Explore
Cpen

i Search..,
| Add to Winamp's Bookmark fist
| Enqueue N Winamp

J| Play in Winarmp

Shiaring and Security...

I 2-2-2004rep

IR R W [ T

‘ Send To

[ew

Splitter

Splirter -
Splikter

Spliter

Create Shortelit
Celats

Propertes

L' 3y, Floppy (&)

5; Close

T T

*‘§§3f’§%’3'}\mfgw~_w.w ﬁ;’g
N o) 1

4

SeViTn T

| wyR-23 : el
213, 5] A fesasd g - dd 2l gl oL, A flesedl ount s15en Ui
sON vl Bt sacusll s18ad s otedl asi ®.

) I[IEXI;IOI e
i Open
Search...

- —

Play ir Winamp

Send To
| Cuk
4 Copy
d Paste

Create Shortcut

Delete
Rename

ﬁ Projardes

.

Add to Winamp's Book mark list
Enquee N Winamp

: Sharing and Security. ..

214(d-24

¢ 20U Sl Aim el oflw d RS nan ¥ Slesrd i oteaal ol

19, A Slesaluzis 52, A uedlell Aell Gu HGRid Ay vlert (Bets sl GUR  oldled
L8 A A B, Aulell Rename GUR (Bl saiell slesq opdl AU B,
%, Sleszell orour s18al uaieall s7A Gur Wl Ba sl wel sidad, s oedl

AsU D,

w8l §lesre, il oleeicill Ale T ASY, Mo ¥ glesad A sedal Hio(lal ¢l d

ez [Beus 531, 24 alr wedlell el olley avict (s sl Q Slesd s oteddl ustd

8. 2o 1A s15ed wat ollew A A seell usn ©.
A i14R-24 1L wiesll Propertics l 2t > dl 12 3l 1t R 1A

8.

75



76

i Type of fila:

L opens witi:

Localion: (1S
"~

1 Adrwessd | Toacyy, B Pale iy, 2007, 7 b e

Siren TN 20 iy iea ) |
T R o P H
1" Crmmiwl Frelsy, 17 March, D006, |1
i H
| Modifuy “Eamndap, 19 Mareh, 2008, ¥ dang 4
i i

i
#
£

oAt aadenal [ iren, E_...‘f"".'".“....'le {

2u4ld-25

w[guL Attributes i Read-Only +{l uxigall sl apeell wat vuell 1S 2 54
Wstell el ety YRl A1 ULl 53 wsidl el 2um 2oLl sSan] Al SRl
AHIRL AR AL 527 2al Y AR Ad) s15e- Attributes % Read-Only. | uaiga(l
SAUNL2UA B, A Attributes 4i Hidden +ll uzigall s2cuell ddl 156 Rivdlss 2 saezas
slelaciii el efl. R R-dlos Asanedr4i Hidden eidiad) A WAl olsam 53¢ Sy
ol o Hidden $1ee [~ As2udlazui At 4 8. R Asawedlzasit File »> Tools
>> Folder Options... Y2 (s s2aizll dondl Redomi View Soixdl Uaiedll $cll 4oidt
[A-dlosii Show hidden files and folders [l uzigsll ¥ «uaieoll sadel] Hidden $164,

Al Hadl el 2uM 2oLl s1Sad) vioR ol vel wiatl el Al €y dl $15a- (3

gl Attributes »i Hidden l uaieoll seumi sy & |



Ssu-e  an.AA.a8 (MS-Word)

6.1
6.2
6.3
6.4
6.5
6.6
6.7

6.8

6.9
6.10
6.11

6.12

6.13

* UellaeL
udlay, | _
Ms-word 2003 -} yru QAN
Ms-word -l ﬁl?uﬂi AN !
MS-word 2003 3¢t
File Menu
Edit Menu
View' Menu
Insert Menu »
Format Menu -

“ Tools Menu
Table Menu

Windows Menu

7



78

6.1 uuia-u (Introducation)

Microsoft Word . sl MS Word ddl3 sdleiviaini 214 . Microsoft
Office 1l »ldel el el A152Auld 25 Ws2edr MS Word 8. MS Word
Al Gualal s3AA ogel el UsiHL 82c1d% (Documents) dUR 43 A1 .
ectld-{l vl 53 2sd B dal d-l Mot (Maintain) 219 9 513 Q
1AL HA D, UL AL SIHS1HT 2 U SR m&aam GualoL sralel] 514,
g A0, YL 2 U2 oA 6,
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Microsoft*Word 2003 2 Microsoft Office 2003 3i 414 gd 11 el
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URL 53] USIU D). 2L AF2AR IR AUIR 53 Ll ABRHE cURMHL BiadL S5ULL UsIRAL
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ML, %l 3 agorRidl, B2, adlRni uaL srelider AuR s30 Al el A weL wsy B 3
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AL QAR 4 w43 B, ‘

it WS- WF2ARA QUIR - alellord, Heal - A%0LR-L A Gulol saell s1m
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6.3  MS-Word 2003 -l 3y [Qdndil :

. Support for old version :- Word 97, Word 2000, Word xp i ei-i1de
- S8 Bl excidy Word 2003 i vilel) ustu 8.
. XML €zt Aoienss 8 :- XML Format #i Word gc1deA 2ia1d] (Save)
wstd 8. Fell vl exdldogi Well Content «l Guailol B data-mining
eI RIS Y

. YA YRl - Word 2003 i Word il udelinil 1§24 sl el
af a0l izl asid d 42 Reading Layout View < 31142 534 8.

. Ink devices 2+l YA :- Uy Tablet Pc %l ink input «{l Ro1cs 431ddL
Al WA Tablet pen ) Gualol s3 2AuslL sadisR 4l Word 2003 i
ERclldy AR 53 AL o), UL SR A tlde outlook [l Heeel) e-
mail Ul 53 24 8.
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Menu 3 2uddl €ompare Side by Side With.... il [seuell gacldy ag il
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253{ & Ansllotern 21y oiseel eledl wdl A3 9. 24 [QdNdl Microsoft
office Professional Edition 2003 yag, *alRd 8.
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3 [March 2007
Mmd' 07

Mar-

:mrmo‘: 1137 P

gs.rtamua* 14379 PY
A2

Auto Text :- 21l sl Heedll % 2168 3 w0t Al AlRaAR 3R Uddl $lu dnl &g -t
YL AU SUHE 210 B, r3[RuULd Yorer A ectder Hi GAA wsiu &, el s U
2R 05Ul 49 griolet ot § . Word 2003 «L Auto Text 2ioueui 2y %33 206) ¥ iR
BRI 2Ll Sld A GAZL w8 9L, 2L M+l {12 w1 D AR,
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Guyarat Vidyapith
Nt Income Taz
Ahmedabad -380014

WWord will create an AukaText esntmJ
from the tr_nren} seloction, v

Elaa.-a name your AutoText entr

214(d-39

Qe :
- g Text GRUHPLG, muaﬁ -39 m otctie 38, Work area i
C oAl

- an uRe 53,

.- 2wl Alt + F3 st el w&qt Insert > Auto Tex > New Ag, W

EPEDR

- Create Auto Tex dlalogbox (214(-39) Beuidl.
- Al asidl Text o &4 «un avll ok sle- Pz (Bus 52
- 234 sl 211 Text, Auto Text i Audld 4 .

Auto Text ) Gulal

Aa :
o1} eadldy Auto Text 1l GRl MU %3 W AR Auto Text i gt
Ul avle ok avll F3 g0 gorlal Ayel qilRdl eadidaml 2udl i, stadl
Inset > Auto Text 33 d vl Auto Text +iL £51 34 Gu [(Bris s 2iyel
YR tactidormi 2udl 9.
Symbol - Ms Word i 2= 93 suisas (Keyboard) GuR 2413d, A& Ridiarl waR %
Symbol 2130 ip1dld ade & (¥ chdaz Gyl el ell) an et Hi 3l a GRraL.

¢ ™ [ o ';é"'zé'lg@g%%; T""_a,
e RS sl NelU Ny |
~F= = o[ L= el [ Fe
(Ll Fl=]il|p 1l O L lL"-'= ™

_|1 frop |Unlc
sharteut key: 2207, At

215(4-40

Aa:
- Insert > Symbol sl il 2gf-404L ticioil 18l dilogbox guiidl.
%39l Symbol Gu2 A cutc 315 AL (B4s 53l 21l Symbol €2l #i Courser
100 % UL 84 Al GRS %



Comment :- Ul viisiiell Heee] t2cldy 1 SLS Alss A Gu st, dwel 3 QA

ysel 914 dlydlasiu d. ¥ wsR-4140 oion wud 2w,

Offe e

2u4d-41

"a
Comment ysat-ll Ad ;- Courser A Aoy 8- Gu 34l Insert > comment ¥ilall GUR
(Bas 830,

A4 - View > Markup iisiL »1L vt 08 (Comment) deiRd 8. o Markup
[Rsed on ¢l iR Comment Hgla-4141 dciod PETISEARIES [?{scu off ¢ dl ‘ga
AR B, 2Uy i [Rsed on ¥R off s3 A wd ol

Reference :- ¥ viiaiill 1eedll ogel el Us1eetl el £l i GM wsA D,

a1 Footnote, Captlon Cross - reference, Index and Tables

) ré?%_&x?_':x""i R
e Windo

AR

Break., .
Page Numbers. .

Pate and Tine..
AutoText »
Field. ..
Symbol
Cornment

*% Footnote, .,
- Captlon

 Reference M|l

e JJ Cornginssil. o

Cross-reference. ..

Diagram. Ingdex and Tables. .,

24(Q-42

+ Footnote :- ¥l au-{l Heedll ERALA%AL ERE Wiriril Vet el (Foot-
note) 6 usiu §. Comment ¥4 Footnote A Gua{loL Hl2LHIOL HLg A%
@ . ‘ . 5 5% 4 ]
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3 ]— — (..erlc-al : J i

lg'_ I,r:s_ar'l:

A S e

% et W2 Footnote GAl & A« Gur Courser Ql}’&

- Insert > Reference > Footnote Guz (Bis 53l

- 2i4la-434i tulde dialogbox ollé Aa wad.,

- 2l [Qsc\& Locat10n Format Apply changes Wiell qoy [ﬂsélt Wie
ET I

- Insert oie+, @1{1 [Rﬁs 321

M sl Footnote GARA., e& ¥ Footnote (A2 (A4 -4 21l avf] 914 1. % nan
YA 534l 2oerl Aeofu e

Caption :- 2 a1l weeell Au, usel, Risi) audl %uug ABLRL 2] 35 )
ASIU B, el.d. Sles-1, Aes-2 qon

Al i~ £3cldor QLR 52112 AR +1q) Sles GARAL Y wild £es 26 520 dl Sles MRS R
Avtall 23R Aol A Uy A oDl %),




Caption Al Na :

- Insert > Reference > Caption Guz (54 sc 2ugld-vy di calda
dialog box ¢auxir ugl,

- Label - droupdownbox izl o4 [Asen i 531

: ok o2+ Gur [sas 53,

A4 :- 21 Ry dialog box Gu 2uddl %l el tiert A [Rseud) vea 52 %3 8.

Cross Reference :- ¥l wsti-l Gudlaill Footwnote, Captlon bookmark 4313
£RelAML 541 el SUL UL GUR H3d © d el asmu 8,

Picture :- 21 20l Gualay 534, az«uQ%{l IR oflog, éﬂ&a&zr{l % Word {l neeell
oir1Ae, 518wl Rl adHir srclder 1i @Qﬂ WU D, ¥ el Save Sl Al UL ALy
% Qi AN W B,

dda: Insert > Picture

Fage Murnbers. ..
Date arnd Time. .,
autoText »
Field. ..

A3
Symbol..
Commpnt:

Reference »

Pickure

i

Clip Ak,

Erom File, ..

From Scanner or Camera.,,
[ew Drawling

autoShapes

Wardart, ..

Qrganization Chart

Chart

204(d-45
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Clip Art :

- Task pane Guz Clip Art urie 3.

= Search For i [Quy evdl miad 49 wied) v Go ele- Gur s 3.

- (v el 3 ot o Clip Art stcladl. ‘

- wigall-iL Clip Art Gu3 double click [Ris s3dl, A tcldoi GARUS
.

A4 :- Clip orgamzer 4i drwaing (R2), Photographs (¢s4)), Video (uafit),
Audio () @3 Media $15e 21adl €14 8. 3 Clip ddl A)viaisi »0d ®.

Form File :-21 usi-ll seedl Slvyzni suiy wat Aatdld Rst sadidarmi
GRA s 8. ‘ '

Qa: . Insert > Picture’> Form File....

From Scanner or Camera :- % 522 A1 Scanner »udl Camera
Al el dl 2 2l weeell Ay Rt sacidorst 63 us . :

Autoshapes :- i1 ziiau-ll 4eesl] %el ogel 2R, 5[ 3 AL, ¥ Autoshape i
Al B (2U5R-46) AR ezl v[lvl-{l istill GAZL 26 B sl Al %mz
(el +04) s asia . . '
Qa: - " 3
= Insert > Picture > Autoshape 21l >l 2udl Autoshape Toolbar
(205[-46) euiid.
- el daudl vaigoldll 2anL uale 59 eacidarmi qmd °&qu wudl
w5\ 69,




Word Art :- 2l 2ustil Gualo agel gl Aell-w s irtiaal i ©. wugla-47 4

Lol UHLRL
| ot Qordﬁ" worciac, | Wordnrt Woraact)
il Wazzrt] Worga e
wi4ld-47
Qa:

= Insert > Picture > Word Art »ilsil #tudt Word Art Gallery el
Hal.

- Aoy el waie 53 ok viert Fus 53,

- 2145[R-47 wud Edit Word Art Text dialogbox al ‘Wlﬁ

- i % s eietacy Mol L A 1l Type $3.

- ok 612+ GuR (Bets 531, v urieoll-ll Aell allols diL e2ctdoril AR,
File :- 11 2isu-l seeell ogel 2gel Word gaidos (A ol el s15a) A As o grclAwAl
QL 5T AU B, -

et :

S - Insert > File 20 sl »iucl File dialogbox e, %l File Se-
Ject 5. |

5 Insert ste-i Gur Click 430 A s2aell veir-{l §15¢ dciird gl
G 4.

Bookmark :- Bookmark -l Gulot 54 2llssu Text 3 2usf udeia ol aldl asd),
wac) A iAol % @ GUR 8, i Al ydial], s §. Bookmark vtucudl
S1Sual A2l srcudor R RMAL AL ee] Anad) du AR A 2lug A oA B,
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Qa
- % Text A Bookmark $ai-{l €14 AR uzie 53,
- Insert > Bookmark st »>uu).
24[Q-48 i vl 31l dialog box Al ).
- Bookmark name #i 1wl ¢ Uy, (i eoul vl 91518 Adl) 24
Add st [Bus s2a19l] eadidmi Bookmark GAR1S o).

Bookmark - alge{ q4l3 @u'zaot.
4
-7 Rdldy 1»&c{l Insert > Bookmark i1l 241M).
- Bookmark name {12 214 List *{iell %33 2ige{ Guz llu ue\w w2
% Q Bookmark name Guz (55 53).
- sgirua:’mi_ o digelauq Gu2 Mouse pointer Al 1A,

Hyperlink (Ctrl + K) :- Hyperlink +i| GzloL 816 we 2lee{A link sell Wiz a1u &,
d igel 2oy eldoHi du w3 B, vl s2ldal sl A8 si15a el S W B,
Bookmark 4 g, Hyperlink il aus14 8. _

excllawl 8¢l Hyperlink Gua [Ris sadl di id & dieof Rade ¢ & 2dee! 164
Wl \

L.
Egdsting File or |

44 Wb Page .y‘x}g My Muslc
T e il My Pictures
e ‘;.'J 7 f Folder L5 My Webs }
Placesin This -0 4.3 Visual Studio 2008
| Dacument || Browsed {44 Visual Studio Projects
s L “3~$rdﬂgure2
el S ] e .
- G| e L
| Costeten | | g M adovabih
1 pocuhert - T U] gy O
o \ . Gy fiec | ."" e

25(0-49
dd:

% 2aix B4R Hyperlink Gl & cui Cursor 9 & .

- Insert > Hyperlink 21l 2uclt 204[Q-49 3418 dialog box 2w,

- Hyperlink i % e+l s165¢+) e e 2yl 1iol ) Q yaie 531,

- Text to display ui Hyperhnk g U L. % €2cld Ml underline
Bud). - ‘

- okolert BRus s -

- 2113 Hyperlink gxclderHi GAR14l.

- U o Aeed viledil %32 dlu R underline Gy click 3.,



6.10 Format Menu (Alt + O)

2L Menu Al ezl 241 1 2434 ekl wisud Al 8. (2040-50)

%m&mmﬁé@m’ I

Eonk.,

Earagraph. ad
Bullsts snd Numbaring. .
Eorde'f and Shadlr‘lg

golurnns

t"h nge Case

Bacmyound £ 1 LIS E S i S 1.
Theme..

Frameas om "
AutoFormat, ..

Styles and Faormattina. .,

Feyeasl Formatking., .. ShifFE+F1

o i
f ¥

214(a-50

Font :- 21 a»usu-{l weed) sadldoil e Text -u Font, Font 4 =, Style qﬂi
waald 59 wsid © wadl eteel wsid §. 2 Text GuR €L el 1430 %l 5 Shadow,
Emboss, Subscript 4912 2udl usii &, dal dd udedl (Preview) ugL s asii 8. %
Text -t Font . Size 493 %l 325R 53l & o W12 Text - uaie 5.

ir All Last
Fank golor i

i Automatlc =
EFf ““t; " IHlfe i 7 L

] str fl.lﬂ'.hrouoh l__| Shndm . 7] small caps
1 Double strikethrough )l eaps
[ siparsaript C:] Embcrss [T tidden

- [Z] sulseript ElEngroxe

el e T e S e i
| E— Saumnple i Gelsru

f
i Tlyis Tort Wiz not bhen natalied, e closeat o aiabls font will ba ;i:iniad
L b 4

i4la-51

Format > Font sl 2ucie]l Font dialog box »ug-51 1ud. euidl. »1él Font
dialog box i 2idet e el Rseil- Gudlor s3 i erdidey »i waie sl Text el

o) 23Rl Harerl R 2l wsl el

= Font Color droup down list box Gux (5 5212l Font color set

s usU B,

- Underline Style Gux Bs szl el el (Single, Duble, etc)

usizl Underline Style Text A xudl asli 8.

n,

- % Text A Effects ailotil 20d¢ [Rseul v 2uudl 8, d Text wrie
59| Effects check box ¥ sl d 12z Text GuR aal 3ud.
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el.c,
26" January aval s o
- ude 26thJanuary Type 52
- th Text - u3ie 52
- Font dialog box #is(l
- Superscript G4 V 53,
H,0 vl U : ' .
- 2% H20 Type 3 | ' :
- 24wie s
- Font dialog box i\ Effects %2l Subcript Guz v 53).
2% w118 Font dialog box i 2udell %el %t [aouatvu el el [Aseundl diRl sl

4L GuyloL 590 s 52,

Paragraph (W[2209¢) :- wu 2usu-l #eedl R (Parapraph) I oleant, ¥}
wua -l 2ol s2ell woul wladl, 4 Rufel (Alignment) a9 59 usiu B,

Paragraph dialog box «i 2{35 [ayey <l IR RAulesis] R GuR zéa 8. :»touév{l
dilollell Higs L viigl NN A D, '

Tndarits and Spacing

ey aly S Cat
Allgnment: il

4 Indentation
©gpft:
4 Luight

F{erlﬂll = £ =
fponey Wl L

Sl
Hirfurel

: s Lt e LU
After: |

i Single

Freylow

2145[d-52
{a: ; : i
= naAH el Higll ¥ uRae~l osael sl © A urie 53
- cURete Format > Paragraph st 2.
- W5R-524] "tcllc’-ll wd dialog box Bl 4ad.
- ¢l Indents and spacing 4 2113 L gl Rewwolil, el el Reus
- eacdopi Guallol £4) Asiuell 53,
gl.cl. :
Spacing [Asoi el Line Spacing [Rseusll Gudlat 53 udladexi & €l
a2A-{l apoul J2ell vl B A el wsid B

Bullets & Numbering :- ¢xcldasHi 2106 quiigl R a,aw.t AIUHL dvialy slq
R Bullets & Numbering 2itstill Guslol s2aiMi 201d 8.

- TS T R CTECK ) 22 sl 31{‘{1 AU, ARl UsU B,
- YL A GUAEL YEL dlRalal HIR el el UslRril gl Guylol seumi
2014 8, x1dl sl QRN us1R dNsarll seuni 20 B,



- 241 sl olleda HerHl wesnell usL A1 +tdl Hel, gacldey Hi e
Yeill u3piladl, A2 Hadl il GRRAML Y 518 AvtaHl 20, dlugL
G4l Held 2iset, A U el 512 8.

215(d-53

et : §
- gaclorl 1y 1S s Hal avil.
- 3 uait 53 Format > Bullets and Numbering 2l 21l
- w15[-534i tafda dialogbox Budl.
- wpu+ll ar3Rutd Yool Big waieoll w2l Rseu vale 5.
- ok ote- [5us 5.
- 3 el 41 NSARIHL Al YL UM GARCAL A, 2l (Bt o33 HE sl
4. :
- Word vt 28 3l oy adsagl 523,

Border and Shading :- a3t gxatdes i Uy 3 (Bl Yscll HI2 vl s A5

3oiel] £9LL 2L M2 2L Bl GUAloL AU . ‘

- Format>Boarders and shading »tisil 218 Borders and shad-
ing dialog box Bl HAA.

- dialog box i 3va 3L UL 8.

(1)  Boarders . oS

- Borders st iidl 4da ¥ Text A Bidl 52l & & Text writ 4.

= Format > Borders and shading -l 2Atsil 2. '

- dialog box i #3Ruc Harei-i Rsen ie . (Preview. 2 512))

- ok ve-t (Fus 531

109



110

(2) . Page Border 2L ausiiell segell i) 533 Brtid) 530 91514

| P vimi
AiH Clieh. v ellagram helow or use
biftténs to apply borders

|
|
I ) ;
|
H
|

3 dze

[ S L
wan i [

- Ry A
|- Iwhieds dacummnt

(3)  wiesd Shadingcuad, wis s3e 3014 o1 Al 2514 . igla-

5641 Pageborder »13 Shading v11si-l) {eeel) oiridet eacidor e
0.

v p ueh 2o Indentacion and, 31 bgnmant, |
by pelecoing opoions In the Pavngraph dialog bon. The availabiliby of
roms opulons depande on She languages hav ace insballad and <nabiea for
adibing.

graph sattings, such

Indgnns. and, 3pacing nab

General ; . @
®
5

Outline laval 3akact an subling laval bo apply us oha salacead
cagraphs .

’ Parageap] .
¢
Diveskion  Specifiew bhe directlon of a pacagraph.

4+ Right-to-1eft  Jee» the al
pazagraph vo eight-vo-lets.

# Luaft-to-vight  3ate the al lgnmenv and ceading ocder for s
paragraph vo ledb-vo-right.

Inviantattin
Loft or Before taut Enber ohe amount you wank to aph

™ indent a pacagsc
£com the 14fb mazgin. 1€ you wane Saxt %o appear In Ghe Lafo marging
AT & negavive number. . -

214(d-56

Columns :- £[Rs Watig @vilel et 2a3umi dlsUAg €lU B, B USY e Q1R
SAML HIZ 24 Bt Gualo] w1y B,

Ao : ‘
- 3l He €Al View Print Layout Set 53).
View > Print Layout
: ¥ Text (avual)? adet azuni 22qai-0 ® 3 vale 3.
- Format > Columns »t15il 2414).,
-~ Columns dialog box iell Presets ci1o13 21det Rseimial] 1oy Risey
Wit 53 ok vz Bis .



| Y |-

215(d-57
Tab :- Tab 2 218l 1issll (Horizontal ruler) GuR excides Hi dviigl s4iz] g, ¥

el {4 Rufe (Alignment) euld 8.

st 1A Tab Al Guailol RRR Us1RwL 6% Fell ¥ viHslal uBist, A3y
IR AUIR Sl AU B,

Left Tab L - dleflouy e Rulzel (Alignment) 52 8.

RightTab 4 - o] euyg 4 RufRa (Alignment) 53 6.

Center Tab "L - wews s Fufkel (Alignment) 52 & %ell 2e4+{) ol 6uog ctviial
UL UHLRLHE HAR WA 6,

Decimal Tab le - taii2l Rive uden lis orell ol a1ofl ong 0 WH da eigl Rir
Uil tis el drs Ay Rafe 524

BarTab 1§ - %2t Gu Bar Tab 2iug) cii 20 You Aol wad), v A erell
dR$ quileld Rt Rufe 53 8.

Format > Tab vilail 214t 205Q-58 411 dialog box Aldl ol dxiell oy Risey

Wit $3 ok ot click $3).
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Drop Cap :- % $ 5. Hi-l 233U el UaH 2R “drop cap” sl 112 vit sl Gualol
AL A B, :

Aa:
= $5A WRlE 52
- Format > Drop Cap sl ).
- 14[0-59 il dloy [Asey waie s, ok vien [Bus 53,
Change case :- Text -l case eleddl HI2 1 sl GudloL 2l . Format >
Change case viiatl 21Ul 24L5(d-60 Ui sidieil w118 dialogbox Adl Al

L Gancel |

24(d-60

. Sentence case :- WRi¢ s¢l quuel-) uud 2R HA (Capital Letter) 2.
o132 6lL4lL (Small Letter) 2482 wii-iL 24l

o lower case :- Yig 534l ol 2182 small letter 2.
o UPPER CASE :- ait1% 28R Capital Letter 26 xq.

o Title Case<- Wit 53¢ cvildidl e35 Aot Uy 2182 Capital Letter ud
oSl et o Small Letter 24,

° tOGGLE cASE :- ui¢ s2a avuai-il €35 Capital Letter, Small Letter
ug§ %9, adl Small Letter, Capital Letter 48 o4l

Background :- &d1d%4i [A[Q4 Hsi+1L Background Set s34l Hie v wusti-l Gudloy
a1y 8. Background a3 Colour, Texture, Pattern, Picture 21ql Text Set 31
usty 8. Picture dul Text A Watermark ddl3 ugt Set s3] 2514 6.



Format>Background sl »Uudl »1gf-61 1Hidl Ag Aal wadl.

Theme :- Theme -l GualoL $31A YR 2-aly] exdldw ei-licll asii 8. Theme 3 el
el desing elements 247 Color Scheme -l 43¢ ©. ¥4l background, images,

| it Eéﬁggﬁ bl MMF‘E:!Q»@‘
a

i Font..

Baragraph..
Bullets and [Hurnbering.
i Borders and Shading. .,

i Columns.,,

Change Ca,e
Background >

s Therne. .

2w15{d-61

bullets, fonts <913 elements «l 1AL YA 8.

Qa:

Frames :- Frames i\ Gulo -4 € Web page design-il sacisl U3 8. 2As
Web page i 35 53t 442 Frame 2udl 23 6. €35 Frame 4 Content 2431 2121
Sld 8. 2 Content A AR dDsadl Hi2 A4 Content A, Frame Hi [Acisaim

R!D{Jle .

i Sath
!Saturday TY Teons
-.i‘_-;ky
|'l|~3i0
|| Sonora
Snlch

i ‘tldd‘ﬂ. Edge

| Gurl Palnting
Suriflower

i
| Romanssgus

Stiddio p

& Bullet .1
# Bullet 2

| Sweets .
1 Tabs and Folders
‘i Technology

Tidepool
Tile
Travel

[ Yivid Golors
(V] Active Graphics

Jﬁﬁcquomd Imuge i

@ Bullet 3

| 'Hordzontal Line:

| Heading 1 style

Heading 2 style
| Regular: Text Sample
Prquldr HyNJLl]MK

) [[caree

ﬂtlélleua!h:ry ]E ofF I

Format > Theme Guz Click 52l 2u5(@-62 1w dialog box @il

Ol

aldl wiedlld Tehme uzie $2. ok oizn [Bes sl Theme Al 21242

a»ugl?l—.62

AMIL £AUA% GUR 2Adl 1A,

219 8. €35 Frame uld ual A5 Web page .
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Auto Format :- Auto format -} Guslol s2ciiel) s2c1domi 38 waoy, (heading),
(%ig (Bullets), »is wi€l (Numberd List), 3dls (Symbol) a3\3 2 ssuell %43 2201cel]
Format s3l as14 8. 24t susu-l 4eeedl e-mail Addrers a2 Internet Addrers <
Hyperlink 3i eiee] asiy &,

@ hyphens (___) A(__)sisteel asu®. Font Command “i Effect
Select s3 default Guz click s« auto format 88 xS, o412 518 531 % 1A 3o
AR AUl €1y ol o A1), Autoformat Hisll Ul usu B .

Style :- 21 susurl el adiin L2 vl 20400 Style 20Ul wsiy B,

Object :- 2 va dd uaie 53¢ object u¥13. dynamically eleeud 8. A Bt vzl
523 dl Al Picture oldtas). )

o st 2l Ristd 3y, 301, it 4 oieell wsid B, 2um R w1y Text Wic, 520
ol Argi Text Box Rl 4012 F+i Guz click s2a180l uaie 53¢ et Text box i 2l
4.

6.11_ Tool's Menu (Alt + T)

DL AL oEL B USIRAALZRLAAA D, Feld A8l L eLsa CIERCTETERERIEL )
URIA ANaaL 42, eactder A yrelld s2aL w2, [Rsey YRIE, L UE SR HI2 991X,

Spelling & Grammer (F7) :- 21 »usu-ll ueeel 2o casa 219 Bl
Yl asiu B, S5 un uoe-ll vildl Al ouis) Word 2003 o 216t 33+l il Rasll
el 8. % WY A sead WL Qa ) siedl wg Bl v ot 1A Ay Aa
ol A enfd 8. cusaal oje ¢ i el 3ol A eald B, -

5_% | Elﬁtﬂ: Onca B

Tools menu, and then clek Internet Options, o ——— "
(o]

[ dtoDitonary |

e [ G|

To check your cunectinu settings, click the

convecti flf ==t
2 Jcméctk;'gﬁ JZ;‘EE_J
oot (B ) |

ok yrwtne

Ad
= - Tools > Spelling & Grammer 42 (5 521 13 yoyoil dialog box Aat
wad, ‘



- e [Qseuniall Woy Rsey urig 53w o).

- Diﬁctionary lépguage jef] ﬁél %¢] Dictionary it 53 dsiy.

- sl5usL il 906 & % Dectionary i -2l & w65 Add to Dictionary
53l Dictionaryi 633 usia 8. '

Reserch (Alt + Click) :- £.5ugt 20e-) -0l 2108 alual U3 2 2hsiel Guadoy
WY 9, '

Set Language :- 211 2uisti-{l “eeell afl daidl er3Rautd 3ot ey vaie 59 29 o),

Tools >> Language > Set Language Guz (345 53¢l (utg[?t—64) -\ d1alog box

el o)., ' . ¢

-

Guaral
| afrikaans
Albanian
Arnharic -
A ; F'.rahlc (.ﬂ\lgerlaj

'5.The spalier and ni:he,-r P a
use dictioriaries of the ,e!ected Faﬂguage,
availabls

;]:] Do not check spa{ﬂng af gr arm'nar
] 117_] Datect languags -autbmatl-:aily

[ Qefaurt —] [4 [ Cance!_]

24(Q-64

Translate :- 21 2usii-] seeel] excidorg 3o eunmimiel ofleo eunin wigere 539 w6
#9L. 21 42 Tranlation dictionary dm1z, §12224i Install 23el &il RS,
(»usu Tools >> Language > Translate )

Thesaurus :- 1 2l #eeel aniuels uoel Ml wsu B, woe wie 58,  Toos
>> Language > Thesaurus sl Ul A4l 9162 Ao Had.

Hyphenation :- 1 2ustl #eedl qriat Aflu-Fufie (Alignment) «u Aselui
AMscudl, aet A A 43 1) ol 2un A avuel oo A amicig 43 1l WALy
U 1l yd acl) e 213 26t 2149 o dL A ut ol ldsti sucl #d. A Hy-
phenation on 3 dl 24yel 26 42 - 2iad A oudl-l wse ol dldui avd.
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Mark selected text as:

I
| Gljary i
| Afrikaans
| Albariar
[ Amharic i
frac oenaly v ]

The speller and other praofing tools automaticsly
Use dickionaties of the: se!-actad language, {f
avallable,

[ 06 not chack speling of ararmar
[¥] Detect language automatically

[Qefault..._. ]I oK j ,_I Canicel

115465
Word Count :- il 2uati-{l #eedll duil edldy-{l ge wtissisly 1Rl Fell 3 wisl,
og, R (vl ooyl wd), e (uidl oouL aar), s531, dlZl ad-l dvay ogia
Haal.

Auto Summarize :- Ayl excidy-l [Auy arg Jedls el el yel + €y AR,
RctlA) %l el dd AR Adt MI2 i [QAseu-dl Gualol scumi 20 &, Fell eyl
il Yl s Y,

A4 : Auto Summarize Y12 tld% 218 eig (Well defined) v €ld) 3 8.

Shared Workspace :- vl visti-l] Heedll 315 $3dl aei 4fE s eacider A A 403
8 v drl GUR 1M 53 U3 B,

Track Changes :- 21 sl UL Ul Yo EUAAHL SLE URL 3§12 Fall 5 g @uiig
G2, 0% Al sy 18] il a9l sl 203D dl A el el el )
euldl w54 8. (3us[-66)

. [::J faut omat{cally hyphaﬁata docume_nt] '

: Hyphanat_[on 2018}

- Liralt mrysf_ﬁc[utlx'fa hyphins tal

l L’lamal i | . -O'K. _. ] l Clancel.. |

‘ 2u5(d-66
Qa: - )
- Tools > Track changes »tisil »udt Track changes 13 off ¢4l dl
on 49 dal on ¢4 dl off adl. '
- 2114[A-66 i biciedl uHI8L Reviewing 4 -1g Toolbar @lal 10,
- 52l YHIRL a4l esaReject All changes in document uR (Bus
5l d % 4 WAL 9,



Compare and Marge Documents :- il »tigit-{l #ee2ll YEIRA-AHIA 53¢ telldY
Al acduin g1 Al avimell 531, excidy s oflo (aduict gadides) Wl Aad)
ASU B,

ociing for s cullor.llr unavalatls. Tha Wb sits
nelig techiisal difficuliing, or you may ieed s n!hm!
ANEs.

wing |

ae Reliesh button,or try agam later, A o L g i e {Deletedt,
yped the page ;ud(lr in the A(lrhrqs' Bar b it W P i

ure that it ig spelled cotrectly v L4
sk youwr gonnachivn settings 2vigyg,, click the |

and then chek Intetnet Opt Onthe, . ik
clions tal, click Setdugs. T gs |
match those provicled by your Joca) area

< (LAI) administrator or Internet service i
w (ISP) Fuonls il

2415(Q-67
Protect Documnet :- it ustill Heee iy yela s34 wsiu 8. Tools >>
Protect Document GuR (5 53cll 2415[-67.1 #i o4l s eicdet task pane (Pro-
tect Document) .l 101l %33 Rseu waie 54 Yes, Start, Enforcing Protection
U2 Click sl stoll 48+ dialog box el 3aal.

i puceptlgm (opl'lomll)

elect s:aart. of the du—cumer.t. i
o land cHonge Lsers who gre 0|
allowed to freely adit bharn. Az
e ‘GIUUDSI

25[Q-67.1
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Enter New Password (E)ptional) uq Reenter Password to Confirm i wyad
Type $31 ok vlert GUR (518 s3di saclldos yelld wd ),

‘Mail Merge :- 21 ot %R 88U ot A £35m] A4, UL el Ausit R

Rl WA Hseal i AR i 2l Gulol sl A B, 3 susiell -
w2+ Labels, Mass e-mail 243 Fax gx1d% el Q412 53 0614 8.,

2l 41 €ac1dor 217 datasource oY wiedL el SSaH] G1U B, ¥ bl w2l
»id Alow U E3s+ ol €2, Yat, e-mail, fax W3UH] 3AUS WU D,
Y ey -2l Has gy ercidlor ot 3 il avitel, Rl €35 12 WHLL Q).
Data Source :- i1 154, Excle, Access ¥ Word f11e R &S AF. FHL M,
UM A3 m[éc{l sdl.
Merge Flled = 11,01 gaclld™] ‘w cq[’f?ctj, UM, AR-UY AR ETTTRRe Cttt % %[l iRl
data source il viicd] egl d F1e1d A qril Aoy ezuvt GuUR Y. eél a»tuual Mail Merge
ALY 3;13 udl s 63 uonﬂg ﬁﬁg

b e i
el L S Ay e s a i
-thn lakbsr that wach pc-r SOML
racslvew i e |

c:unummun ek |

24[-68.1

Qa:

- YO ERALAY oiellcl) A vilel,

- L 42 Tools >> Letter-and Mailmerge > MaJI Meirge w2 [R13
5. UM sl wU15[-68.1 i villell W1l Task pane 214

- aul Letters 112{& 43, Next : Starting docunient 42 [Ris 54,



b ik ess informe

Mo B i
i x: SR et
Vel Erbry bllmbat 2

Toral araiiss st 2! iy i

)|

L]

- S B sl dotliel

215R-68.2

43 215[Q-68.2 1l elciAdt task pane Rl oL, (el olley)

Select recipients %l Type a new list uzis 5.

Type a new list #i Create Gux [5&s 530

H15(Q-68.240 310} sliog eidAd dialog box (New Address List) @t 3.
Customize eie YR (545 530, %33 Filed el eudl-i Filed sl «lvil 219

H1d] 3RULdA) < Field R ugl 918 9\

Enter Address information i 124l W38, ®UR A ®idlL 2.

View Entries 3l ¢ entries ol
iR due Close olert Uz Click 3.

s 5241] Save Address list dialog box étdtad.

File name 4l s18@d - 21l Save 531

G

skl A _]f.[-jam{\_n Jf;[ Eﬂ'}onﬁ'""[':_
|\, Eneli ]'-[ Eﬂﬂ ¥ IL ¥:_n|m%}_.._. 1

2u4(d-68.3

2115(d-68.34] vlciedt w11y Mail Merge Recipients dialog box i di

enter $3¢ll HURA 1€l 230 Al 10,
ok steri GuR [5us 5.,
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215[R-68.4

2115[q-68.43] oiclieuy wLQ Mail Merge Tool bar ¢ 24 44\,

Insert Merge Field Gu: (Ses 5 Databes Fields cufad) dialog box
Pl 4,

%33 Field 414 2214 Insert 531 Close 6iewt g6i1d).,

Merge to Mew Dacument

Mlﬁ_[&'68.5

2U4[-68.54i vicieul llH‘LQ Merge to New Document Gu? Click 53).
Merge to New Document dialog box gvidl dai 2uden [sed) gl dloy
[Aseu wrie 53 ok stert GUR [Sets sl uat AU u %l A File name ‘let-
ters1’ 2uuAd a4 A4,

Envelopes and Lables :- i1 »iisi-] 4eedl uze{la (Envelopes) Guz :dlsiR+1R
i HLser R, ALY 91l wsL 69\,

Qa:

Tools >> Letters and Mailing > Envelopes and Lables st UM,
15[Q-694i tufda Envelopes and Labels dialog box %l yag.,
FH A1y ‘

- Delivery address

- Return address 1\, i

- 21 AU et G241 Add to Document otet [Bas 530 :



pelivery addres:
iDr B A Gpen Uni,
1|18 G. Highway
iAbmedabad

1

| l.\

B,eturn addresst ‘m i [:]C'mlt
' [Ajay Parikh

i iGujarat Vidyapith

| {Department Of Computer Se.

| {Ashram Road, Ahmedabad| i
l iy i e 8.,

Verify that en_en\re!npu Js-lo_aded befom prlnl'lﬁ‘j_.

bk e ol e st i

2115(d-69
Option ['f?as 52l w4-70 1 °&cu wal,

¥l UY,

T

Envelope Size

Delivery Point barcode

Font

Printer:  Generic [ Text Orly
H Feed mathod e
I _I"I|

lsl

Al

&5 Face wp ( "t Face down

3] Clockydse rotation

i E?_ad Fromg

| Wwird recommends lesding envelopes as shown aboves
W1 1f this method does not wark For your printar, salact tha: |
| correct Faed mathiod, :

215(d-70

Face up / Down 49 58 53] a8 .

Print ele (55 sl 41y Envelope GUR tswdl.

Lebels Tab uaie 59 o330 wR el Ul dlon [Rsen uie sl urie 526l Wil

510101 GUR UL

Labels ;- i »usudl #eeel stow Guz Labels (studl) sonll usia 8. 2u5k-694

Labels
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Letter Wizard :- (i usu-] (Tools >> Letters & Mailing > Letter ~ Wiz-

ard) eeell Lettern Wizard vad) (a»u%[&—ﬂ) ¥l Hvd AR Tab AL Y,

- Letters Format .

- Recipient Info

- Other Elements

- Sender Info
YL Al seeel] el el il vaie 53, @ou Myt iz 59 usiy B, % Plane
% Pre-Printed 512190 GuR 914 4gl w514 9.

¥ [Lh whe Pt it fey
|

|
i (hoans A oaae dagir)
| ety

|
|
|

24(q-71

Date Line :-2u14 113 Date line off €1 cti 2t %a4gll etog-tt dropdown list
“box il ¥loy date format 21y uaie 53] 241 ). :
- Include header A V s2di & il ezcidonti GRS o).
- Choose a page design i 2UAell 21e0, 24ei0) 2x1iel] 4oy Yl
Wit 52 (14 A1) Professional Letter Yaig 53] %.)
5 % 1A Choose a letter style *iel Qloy (Aseu Wit 830,
- Pre-Printed letterhead »u Rsed V sl st 4ddel] ey letter-
head ol sl Guz tord] 1519,

Recipient Info : »1Tab wRle 3 2U5R-7241 oidionl nwdl eS1e1R, AllH w1
AU, @vll oy, [Ase) wrig 53).

»
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Other Elements :- 1<) 21 Tab Wit sct »15Q-73%1 stclet 3l Include w{l

t&oq [Ase on 2iaa off 4 A5 91, ¥ Ay A off QU 8.

L 4

I

1 iide

|

| FEluefarence ting

|l paling
inatrushioms;

] Agorkivn

1 Ipnescti

W glkrmi coplae Lir)

(I o T e 1
Il
it

¥ erch Pote ba iise e s Dodkl (£}

Sender Info :- > U5 Sender Info Tab Wiie sl 2u4la-7441 stdioil e
WA HRA M ok viert (s sl did ue el Rsell, 217 20dell el Gudll

w573

1oy, L clalt UHIRllel Moy Ll U Al o ol |

Sender's name:

Return address:
omlt

,:h,’.m!_‘ M 2 HE

::-[ Comphmentary [
| dosing:

ok tte:

CQripany

i Wrlker Lypist
i lnmar -

N —

4 Infoumation about the pérson sending a letter

Click here to use Address Baok: m v
N

L

Dapartient of Computer 5o

Proviaw

o= [Rospoctully yours,

<A D Pankh

Macro :- igiil-l A3 Macro s3<Mi 2UQ . %R viys- il 2Lssu s14
IR GuAloL 526l Ul €ld IR A Bigiiadloi uen Macro ddld isie semi a’ud 8.

24(q-74

L [%%H Macro Recoding sl WAD.
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Macro Recordjng :

Macro 3

} gj Macros. . A+FS

Qphons, y & Recard Heb Macro,

=
e %%

i<

SECUFEY,

Yisual Basic Editor IP+F11

|

Enclogure (1)

e '@".. M
S ~<E ﬁ et e
o e e e

e G Microsaft Script Edivor  A+Shift+F1L

=

24[d-75

A :-

- $15{Q-7541 sttt W1l Tools >> Macro > Record New Macro
RE DI -

= 2115Q-75. 140 ettt w1 Record Macro dialog box e 4l

- A 51 Macro i) @1 asl ir3u Macro Name ¥l ok 62+ [R13
52,

M I'o niaie
i n wmau ol |

‘m ST ST e R

Toultars ! [ g J Keyboard

Stoe aced ind LS i
| Al Diocuments (Nc vl doJ:}

._L_Ies i |pt|¢n
:Macro recorded :3; ?9;‘ ‘Dﬂ? by ajay

[~ ek j| !;ar;car }

24(d-75.1

- A14ld-75.240 gl sy vl WA Screen Gur “Stope Macor” 1A
“Pause Macro” 3\ & Symbol Bl 4.

L % e Macro i atdld s2a-l & celint B2l GUR YL ma ax q
Recording adl o).

- AR ¢le Stop Recording uR Click $3).
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Run Macro :-

Qa:

Tools > Macro Guz [54$ sl Reéord 53¢l Macro «lL «lM i,
33l Macro Wit 53 Run ota- (545 531, (bitg[a—75.3)

Macro i Record s34 »llisil v1s Ul 3L $1HL viHe U,

i ;é

M auiry Vs
i Sl
i_%r'h-_“n B Lt B el = 1 e

25753

Template and Add-Ins :- 2t 2tsu-{l seed et Eactilop wiex template G4

ust B, auRixl template Golbal templates d<ls GR wsu 8. %4l d-u Macro

auto text, entries 217, custom command +ll GUloL 2y €9,

Options :- 113+ 61g% vdLA 8. Ms-wérd AL AHL 4L o [Ased) 241 A widl Set

5L YD,

e . 5

pos [/
‘ ways create backup copy  + ] Prompt for document piopeities
| 1 Allows fast saves [ Prompt ko save Normal template
| [54] b backorei | Shve dats only far Forrns
|

ribad inguistic data i

fx NI 11 gk 144 Fl [+l LI
[ Mt boeal copy of fieratorod o oetwoy i or remavable drives i
[F7] Snbrm Abitoltanovi (i e v i) i et es |
|

ave Word (s a5t | Wi Dagument (% s ) |
I ) sk Foaton e Wil ocucedd arfto| P o ] i i: i

‘ |
b e e e e oS e = =i i

| oK ] okl 1
e =

240476

A15[A-764 il Wi option Ad 4l 12 el ¥el Tab 2ude . %41 3 View, Gen-
eral, Edit, File location, User Information, Print, Security 4ol%..

File location - 21l Tab GuR (&5 st File types i1 location A @2ldl el %EL

sedl Al 1 & R il A stedl sl ol
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Save - 21 Tab -1l el et [Ased) 1idl

Allow background Save :- »i Rsey v 52l A 20y, Ms Word i st
5l 82l IR LY S AU UYL 2R 1A 2 AN Save 4.

Embed True Type Fonts :- %% di txdiderui True Type . Font )\ Guxlay
sl €l R, 20 Asen v 53 ¢ dl, sactdor s oo SR Gua 3 o &
Font Installed -l €l dl wat eadide vlady d dlou 2430 (40) Aat qad.
Embed linguistic data :- 21 »itstt V sl sizell adler qvirel da e ¥ay
data save s{ asu .

‘Make local copy of files stored on network or removeble drives :-
AL A 2R A2l % gR s3 usd dal A GUR 51 5L SLSH Al
R, q42u-t (Data Loss) s12sicial 32 v Rsew \ s o380 8.

A4 1~ S15uel dialog R af MR Anda 2 2UER-76H1 el eim ? elqida &
it Gu [Bas sl A Rseusdl QAN *wRdl Guasy 3.

6.12 Table Menu (Alt + A)

U Al s1es (Table) A @vidll 2gél %8l 21U det Submenu el . (215R-77)
sles AR sl %l gl A B, F4i Table Autoformat el 401 L B,

T

Crave Table

Insert
Delebe
Seleck >
Merge Cails
sl vilelles . .,
Spiit Tabate

Table autoFormat. ..

autoFlt »

Feradivmg Faoves et

Converk »
Sork, ..
Formula, .,

Hide Gridlines

Taabdm Propirtiss. .

w5(d-77



Table Auto Format »tatl 2Aruciell 214[-7840 safeur sl ogel %el sles Ral
HOWL. 2 Stesiel] il wrieoll o Sles vale s Qud o3 Yrir-amIRL Modify stest
(5245 5309 54 udl 6. (2u50-78 Modify Style) ok etert s YaiR-amal wd o
Ares duiz WU B. Apply ole-t [R5 sl Table excidori 9l Q).

P B b L |

i,
i, 2001 e i)

2&1@[&-78

Draw Table : »u »usu vl Tcona gl 2usil 4l »i 08 115R-794i
el 4413 Tables and borders, Toolbar screen Guz a4l ¥+l ueedl »uud)
%4 S0 Sles SRl LS & A Hhes AT usta B, Ses O ellu uedl 5900 Draw
Aq 21824 Gu [24s s2clt Pencil Icone el 30 Icone »udl %3, N2 ¥ 241us) 3o,
Draw mode #iefl R[] eacldAosm uiesr 2l '

2014(d-79

Insert :- »U st #eed] adin excidorl Cursor & 21 GuR ¢ i sves (Table)
GRAL 2813, 2UL sl 2L 2A5R-80L ctctiol 1418, Insert dialog box el 44,
%l Numbers of Columns - Numbers of Rows, Input box i BgEH Slegl
i (Columns) 1A 812 (Rows) [l divayt euil, 1 Riaiy olfl- Rsew da s ‘Auto
Fit behavior’ set 53 24l 9. ok et (Bis sl admirl 2o 2udell 81R 1A
eotr] dival wlag sles sl .

ke of cones
Bdral R Behaiar ||

1" Ramanibar Aevanpona i, riow totila

il i ]

mg[&-so
<l : Table A L 2135 Rsey disable 2viidl 24 [Asey R Cursor 4 22+ Table
g ¢l R % enable 4. £L.q. Table > Insert > Row Above 2% 43418l Table >
Delete > Rows 4313
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Delete :- 2L 2118l 2UYdl Ul d1I2 Table vtudl Table <At a9l A Red ¥ ¢ viyal
ot uie 5L o3 8. 2 uedl Table > Delet > Table 2ua 244l ol Stes (Table)
g2 g, % HHIQ eR, xde Delete $31 asiy.

Merge Cells :- 24l 2Uigtl §lesHi 8¢ s 53di qiR Cell (vii) A dlaw st 13 53
8. LU ¥ 1551 53 WAL Cell A A5 Cell 1l G19LL 4L Hidl, 69 AA uxie 53
Merge Cell sl 2L, 21 6i8L % Cell o 215 o Cell Hi 3uicel 2 %9,

Split Cells :- 21 »usit Merge Cells »istell aeri [A3i €. 24 >usiefl 3is Cell A
s sl atlR Cell Hi [Qtiod 53U asiu 9.

Auto Fit :- 21 2tisi-l Heedll slves o3Ruld Yool 2utal [Qsedaiel 210y [@Qsey
Wie 530 exctldarul ollsell austu 9,

4 Autofit ko Conkents

- HeadingRowsRepeat |24 AutoFit to Window

Convert b rij“d Fixed C nlumn Wldth
f#l S0tk iE DlJrnbutu Rows Evenl;f
© Formula,.. ' JJ Distribute Columns Evenly
2w5(Q-81

Heading Row Repeat :- 241 vizi-l Heedl stes-{ uan ek Heading ddls 2l
s sty . el wAR SR, LA Hi 2Ls sl A WirHL Radel Wi e R
@12 2 Uy Heading dd3 £35 uidli stes-l a3viia+i vudl ol

Convert :- 21 st Heedl eadldei 84 text A table 1i, 14 table 184 text
L AL textAl 3uladld 53 s .

Sort :- 24 il needdl slesui el [Addn Field U+ Asct vtedl Gl $Hui
Al wslU 3.

Formula : 21 2usti-{l Heedfl 2004 slesHl Huleld 2e3uHl yoirl Gualat 530 oetddl
53 sl oL, 2usla-824i vidieul w1l Total Earning i1 Total Deduction il
oin acledril ARV Total avia sidi, Total Earning i1 Total Deduction avié
a4l 3120 Cousor 2 90\s<l Table >> Formula viistt »iiudl Formula dia-
log box ol Hudl, FHi Yot = Sum (Above) iUl Guas(l vl -l ¥l
s, ¥ A Cell i 43 &,

2L % {ld Net Salary %l Formula Field Insert 53\ Yol el Toggle Field
code 52l A C1 Cell «{l Baial D1 Cell -l B slie 53 % & Cell “i dstad
459l (Excel Worksheet 1HIQL 12 v ad¢id 2ol 2ud 8.)



Employee-Mo | Name Totel Eaming | Total Deduction |

1 Rameshbhai | 2100000 | 250000 I

2 Ranleshbhs [ 27500.00 [ 75%.50 (ee2d # M

3 Dalaviben | 2400000 | 230000 (=e2-d |’ oy ’
Total 72500.00 123345 (=ed-d i peste

Forfiidal «

[=SUM{ABONE)

bt foimat) . _ V|5 ewagash,.

l-, . e S Bullets and Wbering..,
Paste function: R pdran 1 iy :

w14(A-82

6.13 Windows Menu (Alt + W)

211 Menu -l #ee2ll window o atdud a a3 6. -

3 New Winovr

. Arrange Al

il | 1 wordrigures.doc

w4(d-83

Split : 2UsR-83ui cidtedt wwid el el sust WA As 2uste Split B, & adwir
£RCUAYA 5L 6L A GUIHL [ReUD 53 B, wUIR Bl viol o o] §ld 2 dd Rdlal
$Ug) €14 UR B Bl vet o GULll iy B, 2UH As o £l & Gl [Asuwd
54 A9 Rflal 590 wsa 8, an A zq,él el wSad, s WA Fdael s w2 A
el GUAlL A 6.

Compare Side by Side With : 21 vusu-l el & 215 1 & ogdl el 15 w.buc[l
AU S,
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ALY

uA-1  siid (existing) scdaa oflog Ayl 2iandld EXETIED) 2A181] Yl
NAU-2 YL 539 text A ol (bold) s3aL 6 shorteut st1-), GulaL $340.
-3 WG Gudlal syl QR text A 3l 1A wris 5290,

nal-4 o Word 43 53 6\ AR Standard tool bar Rell yag wefl, dl Q Rew wd A
' LI RTETEAEN

H2-5  Word 3l HUSlA el 2a3usi 56 56 9a olec 5.

ua-6  Word ereidonmi 2o oyony ) Pag;,e break ysdl 214 56 56 0+l QU)oL 5240)
ws-7 Word 2oy 518ayq Extension 34 9 53§ Qu .

HA-8 465 10 segell 2antl s viteitiel eflog wieusi Cursor il ok 8.
189 Word excldomisl o Aduir €219% e-mail 53a1 M2 5 st U,
18-10 65 56 500D GuAldL s el AL I 2icnl oS wsiy B,
u8-11 gl dot R T IRUE  DTRO R

U81-12 Word trcttdorui 1L sciietl 218l el el o vialdl,

U8-13 Word exctazrmiell 215 A 6 553 ¢ 531 g 524,

wsl-14 ojaiel] $59 26 4 o) Gl dl, $5U7 U9 el 3&? vstl 2Lyl
U%-15 Word €xctdorii Spelling duici-l zél el AR Vsl 2,

W3-16 Word gacidati dil sl utet GuR 2154 3 2811 5] 219 4 Jadl Wil eacttdopl
2UAALE a-l Rl a»uuﬂ s4idl wual.

UA-17 dA A5 0, azcuél%'m WA A 5l AR Wir Bl Mol €l dl 4 View vaie
szal

n2-18 mmru [Rotorrl s¥ul2DL U AL, dal dleiel HRdL R ERTRET R
GulaL 490 26 vyl Gorasll) Yot Ma11 -Merge -l GudoL 594 oyl

U319 MRl add) Gusdlor sAN aidl, eArl5iol el sl Rl w[qg Rkl
5ol 2l Web page ei-ul. (2 Hlé Y AL, [8-€] 3 21l el Gualol
s0 48 ).

U2-20 Macro x12Q g ? d-il $1uel el dal <l Macro Record ERETRELTRYSTE U}
galdl. g

8-21 Word 2003 1 £1¢5 wat wizt Qdadil .
True Flase :
usi-1 Word £cldMi active internet addrers iyp“e slasiue?

ua-2  Enter $0 eopacidll Word ¢cidonsil Ad) $53) G O .

R



n-3
na-4
nA-5
-6
na-7

u-8

Uu41-9

Word ecldaul 51es 219l el el A ervia 530 asiy.

Auto correct vl2! @elol 247 AQ YUd B viwal i R .

witer Aol 2 qugdll v AaL 1A D, b
Copy 424 text A “ix A% tacldaHi paset 53] wsld 8.

Endnotes gcllda~il »idHl ¥ [Qadol (Secﬁo‘n) AL p{dHi Y4 A,

Mail-Merge i _Word table, Excle worksheet 19 outlook-contact «\
GudlaL Data Source dfld 53 ustd.

True Type Font €cldy-l A Save s34 asiu .

u81-10 sesul Header Line <t yuay Cell A Al ddl3 aavial 20d 8,
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wsH-9  Microsoft Office Indic 2003

7.1 Mdlasu

7.2 Indic IME udlay

7.3 Indic IMEVS Hl2aus -
7.4 Gujarati Language Setup
7.5 eRldl Swlsdl Gudlay .
7.6 Bl wud 20
7.7yl S2x3 (Lip)

71 Mdia-y

AUl ML 2] SR

WUSHLg2 2512t 2003 L A1d, elre cunBy Aaydlotl s Aal yomi 1A

8. WARANs2 gt 2003 i i) (vied cuelu oy Syl [3€l, H21dl 49)3)
§rerdurtl GA, ool Guadlsdizl, Aesuell euril el duiR 53 a3 &, Qui
sl Asiiell 59 U3 B, war Wz, Asua, A z»u(aa@,& ol HSHIAS2 )51
2003 i A0 g2z ugL oarudlHi widl 2 Gualol CEl) ak @,

Loz A2 218 2003 Aouell sl s il Gl 1y 53 Al Ay

oieldll, MSERsS 20804 2003 gell o) wnaid Gha AN Hee 3w A A Q.

3Rudl :

Q923 GUR s euNia s 53 wsig sleedl, 5165 ual 51 s10 2N, Yo+
Heedl $rql Fed % U 64 .

et (3g0R1d)) Hi e Adi Reellod 3R 213 sy Mcﬂw Aoy
6112 AL $1HHL Ay W A Gudloy 53 93 D).

2Uls el sl s Guedlsl ay w48 91 sif s ud 9,

Ay 6=\ eend) erlan] o5al HRetg 20U st .

URMtA 28 510 W3 2Dl 3UidR SN S10190A) quRLeL B2l s D

- Al uuy HiSARs2 208w 2003 Aeeu] weild (Install) ade g
33 .

. R s1e IME (Input Method Editor) Indic 2l (Install) s34
u3d 8.

- U eUE AL S 53001 12 Sy 235 Setup s 39 B, ¥

4 A As uedl A ASY,



7.2 Indic IME udluu :

Tndic IME easldl 43l 2uusl 81§ Indic - Computing (4 %l a3t Indic
- Computing Project 3\ 2dida gl (Volunteer) tUl el ulloget . 2L udldlog-iedl
3 clrelu atngla Qi) A dsial diirald s 528, open - source
project ©. el il oM 224 YA 6 ugL ABH AUl eol ¢ 2k 8. 2 (Al ay
#Rd) http:\\indic-computing.sourceforge.net Guz:ll %12, ¥ Indic-Comput-
ing Project -l $91243Y Indic IMEVS 2lls232 Rsataami 2Ue 8. i sl yorudl,
Re€l, $~13, dRel, Hu8l ad1d el Aoeus 8.

Al : Indic IMEVS 015233 open source dlatell aA Yzt 2l wdleaurl %32 el
http:\\www.bhashaindia.com Site 6u2¢l Download 58 2514 8. (i15[-1)

25d-1

IME 2122} Input Method Editor, Indic IME #Sé\ils2 20814 2003 *2 help 43l
w B,

7.3 Indic IMEYVS -l :awu-u (Installation) :-

- Al war Indic IMEVS % §132r Guz Install s3a0 #ioll 69\ il 516 waLs
Folder si-icll A 2ils2ar S0l 2. ,

- Zip Format ®i 2 2ll§232 &lu L & o folder i A\ extract (Unzip) 53\

- Q3 oL $15@ Al 1A,
(1)  Errata (g(@uss)
Errata %1 15¢ %14 Notepad > Word 41 W\C-[H qiafl 289\, i Indic IME 4}
5 56 FnelBaqui s 53 wsid S dal Yeusts A R 2 &,
(2)  Readme '
Readme »\. 1@ ugl Notepad 3 Word i Wlell us14 8. a4l Indic IME 4
Installation 2l AQ 53¢ A RAAD WRA 2udd B, F7 24 Installation
AU APAR Y.
(3)  Steup




Setup U 5156 A A2 AellFaur Setup $15a 0.
Steup 51854 Gz duble click $3)..

Indla tME 1 Satup

The InetallBhisld® Wizard will install lndlc IME 1 Ver, BQ)
on your @oimpuler. To corntinue, wlicl

wu4(a-2
2152 A tldiodl WU Screen 214,
Next ote-t GuR (g5 scll 2u4[-3 eiciedt UM Screen ).

Instalishiald Wizord

| * Select :eiup type

S

it

14(a-34i Custome [QAseu urie 531 Nexd slert (545 sl 2u4[Q-5 otcient 33 Screen
Al HAQ. Fui el o e w12 Indic IME Install a4,

215[-3 4i Custome Riseu Wie 52l 2144 il HHIR Screen a9, Fuidl

i 24, Y6l ourm GuR V 53 Next oterd Uz [Ris s3).



Selup complote

S i Fasirished mstaling lhdio IME 1 onyoul compiitet
Please iead the IME Installation Manual 1o enable the IME.

w14R-5 w1 Screen »04d). Finish o2 Click 531 21506 vicionl i Screen
w194 % Indic IME Application, Installation AL help 8.
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i
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Indic IME help el »uu 13 %3 i 2udl 98 6L, Start >> Allprograms >
Indic IME1 Help > Gujarati Indic IME1 Help '

1 Ul iLgR-7Hi stdleny wd ol suy-ll Contents pane i (Ras sl el el
yaon dst Help Al 1), vl Typewrite Keyboard -l Help eafdd 8.

sura . )
el inatel i Wi LI A e e A gier thin oy mapgi of
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7.4  Gujarati Language Setup

UM erally Alg, Sl USAL 2010 HRUF, A Yasot, w3 Setup 53¢l 038 S,
- Start >> All program > Control panel Guz (5t 43\,
- IR olie Regional and Language [Aseu GuR (s 3.

wlran nmd Wi
oKf_I m i e

; SRRl Tar 1
foeat Mook langleges di
7| select I:hn upp PRk

ol alebtional lnromage,

iaht Anth lnngiinges | :

215(d-8
214{a-84 ettt 1l Regional and Language Options sldlaleladi  Lan-

guages Tab Wris $31. Supplemental language support [Reuolit 2410e uay [Qsc—li
(Install Files for Complex Script and nght to - left languages A\ ady
AV 53, Ok olert [Bas 53).

- L AHA, A % U UAH, et V st g2l dl % 2UMRERL g BiLuAL S

U 234 8 d-l CD, CD drive i 42 %l dMiell 33 Files d A4l 524,

F el 2o w1 2114(a-8 Y-l 2yt 204,

- ¢4 Details... GU2 (55 $3dl 2015[-9 i sl W) Screen Adl 4ad,

I:‘P!! ‘ 3

T Bnerean Symhufk‘sylnuald N SRR
= Write Anywhare oy ey JIFStL
«  Wiiting Pad TR [l
i Keyboard
« s
i é" Speech Hecoonition
|l Guiatatl

;ﬁ‘ Handwrlllng Hecngnllmn

e
g itl Ula thm Add md Flemenm hml.lunn LT :ill'y lh
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."'Jl._gnuuiapo LT
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- Add otz [Bats 53l wUsR-10 w0l Screen Al HAdl.

. Input language list box #iell Gujarati uzie 52\,
: Keyboard layout / IME V 58 Ok etert (B 53). |
- AR 6UE H14R-cHL vl Wi Installed Services Hi Gujarati L HAd.

1nput I:a_.lnggagﬁé‘;_\ T

lGuiarel.i .‘:‘g el v\s Lo ¢
v RelsaiaptE] ABTRIL : e
| Guajarati Indic IME 1 [V/5,0] : =

215{d-10

- A 2115[-9 1i Preferences +i Languages Bar.... Gu2 (%215 531, Language
Bar Settings 4i Show the Language bar on the desktop 4 v 591 Ok vle-t
(5e1s SV

- 2413 522l Desktop Gur Language bar 2vudl.

7.5 ardl S+{ls-l Gudlo - 1
- ol Sdlsell 2rury suf eue »un Word »taidL Wordpad vl
- Alzen 2 Window Hi 1A euori osll dré 84 Language Indi-

cator 2| Click 43l “Gujarati Indic IME 17 uzit 3. "

- s gl dviang w3 s
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0 P 5 O 0 L . I
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214(A-11 i oidide il Gudlol s34 2y ;
- AUdl, 2idhey vl A, vied s U8 9.
= On the Fly Help ON - OFF s3] a4l 9.
- Auto Text on / off 53 w8l ¢9\.
=y fgu %el Keyboard %«
- Gujarati Transliteration (Phonetic Typmg)
- Gujaratl Typewriter
- Gujarati Typewriter (G)
- Gujarati Inscript
- QGujarati Indica
- Ramington Indica iafl £1§ugt dxA s1ag Keyboard uzig 54
ausL 6L,

7.6  [Bewdl-aa-udl 2 R (Trilingual Smart Tag Synonyms) °

L (Installation)

: TrilingualInstaller.msi file www.microsoft.com Gur#ll download 3\
7 |l §15¢ GuR double click $2. |
- 14(Q-1241 otellett W Next tiert Gur Click 3.

walcoma to the Trilinguallnstallor Setup
Wizard

2412

Select Installation Folder
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QR oile Next Gur (Bus sadl Bleuall asuetel (aridl-Reel-»isie) @i 201 dHil
PESETEVININNR T L)

GualoL (Use) :- Bieur - xaurial 208 201 s ddL Usiel 3o -3 8 ¥ Ms
office 2003 / xp i 24 A, 9ot 2Davll $13 B, Ul d Ue-L 2Rl YeL YEL (aperidl,
Re€l, 2idow) et 21 oicid B, |

5 2 20l Guadlatel] Guollsdl il and vl a ©.

- Guodlscl il 2idle 20 25U 52 B, U Bu 200 Al Wil doridl w1
Rl 266 Al @l B, Guollsdl 2Udw Avel oied Auiql pudl ¥ [R-€l wse
gacldarmi ALl Y4l 9 8.

B Word 2003 i 62 dil Type sct el i 41U A U 5[R-1441 sl wwd

Rre el wagl.

- [Rrs Guz (545 52 Popup menu 201, ¥4l Gujarati / Hindi urie s

ajosRlcll 2 Reglui A wse A 2ief qoe Al HAd,

.
top Recognizing "Session”

mart Tag Optians. ..

wigld-14

2412 W) i3l AdlmA oigd doRldlHl didlv 34l wsi & . Ms word 2003 i beals
08 201 3] of Gueien U B, (A5R-15) 2irtiell auR B 2o WiSHlNge-ll doiube
GuRell 3Gl 59l AsU B,
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7.7

yrudl §-2:54 (Lip)

Lip -l 2awm-u (language Interface Package Installation) :

WSsRs2r] Ao w2 (www.microsoft.com) Gux

| Lip.EXE

guage Interface Package) -l s1d 316613 3.

Lip.EXE Guz & duid 3sudfl Click 531
Lip ai 822224 Install 4.

(lan-

R oile 2Us[Q-1 i stdiewt Wil Start >> All program >> Microsoft
office > office Tools uidl Mlcrosoft office 2003 language settings

GuR [Bs 5.

Eniplll ot e oo VR Prabery
4| Hrat (i v
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p )é Opm 1018 K Dt v

I G s i o st
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[l 5 by ) Mrvsoll vl Sl 2005
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i) Lok £ HE Conddete ] A»L Aol etke il Hartmm |
i ] sundirs (i
'ﬁ&, Petiosuls Udatn 1 asvp ]

£ e Reale 10
2 Inteinet Ciphrer
B 1aosoft fccess
B 15 Eplorer
e R

Lo rtde Albttunn
Docuvenrs L TR

S Db ot 1 1)

sauall i Wil Nessenger |
J Y TP 1
S sk ¥ A} Whedons Meda Playes
— N Crbmvem Cant s Conntrate 382t
] 48 o s sue Merosuft AclrveSyic
W e g Dobapareg Tk foe Voot
1 Solnaeds

] ke [ |
Y 10K Curverter :
21 el Lkt Uk

:»ug[a-i

| Userinterface snd Help | Enabl

and dislog boxes, -

are tUfrently using,

Disglay Office 2003 Jn: i
| English ’}'5.:

{same a3 the system)
English

In the Help system,

| Clsplay MBI
: | (sams as Menus and Dlalcngs) ;@g"

NS T

You'eaf) change the language Microsoft Office 2003 uses In elements siich as menus

After: selacting a new languags, you must quit and restart any Office applications you

the Answer Yizard using the

o

it ot

S o

After

2gla-2

igld-231 vdiedl WAL dialog box Adl 1l Auiel Display office 2003 in i
AUl uaie 53 ok etert [Sus 530, e oy 53 ALy 53,
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\\Gyee2007Macully\brp\ - \mca2007 do¢

215(d-3
Ms word A4 s3clL 25[Q-3 Ui blcttodl uHI8l -ngz(ztc[lai Sverdu adl Hull,
Ay : ntﬁ&a\&a{l o 2 Gurel Gujarati_OS.EXE s18a 3LG+els 53 dMiRL Svuyean
2R 5241 & 515¢ Gs.mht %1\ Gs_Gls.htm A1 4012 % Gs. mht s15aMl Microsoft

- office 2003 A dyaidl Serdaurl deeldi Brgd b uMdd 8 o} Gs Gls.htm 21
s1Sai Microsoft Office 2003 aoeiad) (2idl) 2l B,
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wsw-¢  TBIL Data Converter :

8.1  udlay

8.2 TBIL Hierll fleen w33luld.

8.3  TBIL -{l2aiu-il,

8.4  TBIL « wlddld dlvluidm, .
8.5  anidl sufan [R-€li ellaiadla san-l ulku,
8.6 A

8.1 uday :

TBIL (Transliterator Between Indian Languages) % Desktop 2ttuild s curdls
ol 6l aurdld eimi difluide s3g Alg2d2 . 21 Hl$2d gL Ms word /
Text / Access (MDB) s1$axi il eirusi 84 +uldl (ASCI1/ISCl / UTFE/
Unicode / Roman $132) A 6l eidla eusni elluiddd s asud. wssiulse
Al HRld o Support 52 8. vt WAzl Hegdl As s AR s15a el el
slesuiell 315 w1 dlMlaiadld 3 a5 9. 2L 08292 www.bhashaindia.com e
GuRell 31G-eds 53 usa B, (¥ open source 8.)

8.2 TBIL 2 -l flzen %3024 :

. les Walt (0801 2es) : Windows 2000,  Windows XP
. UBus Ael3u- (A Aell3an) : Ms office 2000 / 2003

8.3  TBIL Hl :uu-u (Installation) :-

Setup.exe GuR (84 sql Installation 2ig AL, FHL AUl WAHIRL AU 2iudi]
Installation 1(Zu) yel 2.4,

8.4 TBIL a3 wldl4 didluiaze

04 eikdla sl Word Doc / Text Files / Access (MDB) / Exclec (XLS)
al§23R gkt ACS1L/ ISCll / UTE /. Unicode / Phonetic 3uui duR s2¢ll $isSerd
24 6lle etRdly eirimi dlvlaidrel 3¢l d TBIL ls2dR o 530 wsid & d A,

d ;- TBIL 1$23R 93 52 {13+l 212t 244, Start >3 Program > TBIL Data
Convertor Wit 53 TBIL Data Convertor Gu3 (55 $30. 2u3 s3] {12 1308 251+
Al 4O,

e |
« Data Converter|
sliterator between

ugld-1



AL 2AL5[- 141 il Wi ge AR Us1R $15e Rda 53 usiu B, (Text,

Doc Files; Accress Files, Excle Files) »uaial d®udl 1uRdl & s1Sami 23
8, d [RaAN [Rsey wrie 530,

Go vt2t GuR (55 52 2013 53314 ‘Source Font Selection’ Wizard (2us[-
2) Aal 1adl. 21 dialog box i el el Rsedl-l R Hioul 1, viuar-l

Source Langilage : ol QR 53¢ MR aUL, QY 316a dlze olamiel yaie
5. (Hindi, Gujarati, Tamil, None 433 wiell A Ns)

Source Format : % Source language ‘None’ it 3¢ ¢ ol Source
Format 4i 2\ *1» Phonetic Rset Rl 4ad. »u Riaws ACSIL, ISCIL, UTE
21 Unicode Rsed) Aal yaa), 5 .
Source Font : eucla tisumi 1Rl daz 5241 412 % Font -l Gualo, 54 dlu
d Ul 5. .

Target Language : % M1c{l4 e (Sl elluicl sc Hioll ) d Rl
UL M URie 530

Target Format : % Tafget Language None uzit 524 ¢ dl %= ‘Phonetic’
Rse Format i uale 530 wsall. w41 R SUE ol waie 530 s AL ACSI],

+ ISCII, UTF 241 Unicode [Qseunisll 5168 A5 Rseu wie s31 w59,

Target Font : % 3s12+1L Font ellaidlt $1emi vl wio) ol d wrie 53).
Al A48 28 Y2ucll sLen Rl lluidRel saul uEu ASY,.

Jarudl 184 [R-lui uiadd sau-d wEa

wuH Yl Shruti Font +l Gualat 53 25 ad eiad oi-iidl, (2ugfa-3) 2u

Iamt&%j, -4 204l Microsoft office 2003.doc R4 & % Unicode Source

Formate i Save 534 6,
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a Selsct Source Language, Sowce Font and Targek Language for Conversion,

Source Language

f Gijarati ‘ M
Source Format. I“"L‘J.;;llfudé i i e :_:
Source Font ! 21 e T o :i

Target Language

w4(a-3
w14[A-14i scudet Conversion options #i Doc Files uae 391 VA R GlLE
‘Go’ vlet [Fais 2.
L5241 btcllde B Al 1R 8 Al wlgla-3 4l vl w8l [Ase) Set
440 Next o+t (Bus 53,

Source Language ; Gujaratl Source Font : Shrutl

Target Language : Hindi Target Font Mangal

Click Browse to selsct DOC file{s) to be » manvertad to Unlcods, vshen done Press Convert ko staik,
.

2i4{a-4

R4 £dd 281 AL adl, Al Browse t2r (515 53 a3 ssidd ol
af st waie 53 218 Microsoft office 2003.doc 515¢ % Folder i 23¢ll -
8 el uie 52

14-4 4i eid1da Convert 6le-t (845 53,

TBIL Data Converter - Conversion in process.... dialog box Rl Had.
1500~ 55

Convertiag GiaMidreselt Offkce 2003, doc

usla-5
| méla ydl adl ¥ Folder i 34 $154 sdl Qo Folder i yasidasl wio
_TIBL_Mangal.doc -tiai+ll Adl $165e ottt ¥ 24(Q-7 Hi el 1R
llyiddld edl.



A4 : ya 516 Microsoft office 2003.doc dllaiddld $15¢ - Microsoft  of-
fice 2003_TBIL_Mangal 2003 & %ui _Mangal 2\ Targate Font 1 -3 8.

Microsoft Office 2003 gr<ciqT

TRTAEN - T E-AE YR, ST W AR LS TR

Indtor smévar o am FBIW T & M Outlook i (F ¥ G T WroTEEn mém)
TGN IWE DY & IMETAA § AT FAMNY, YAV, WY, orod, ke araTesd, Wi,
SR e dndesn, oA ayEREA TARE Nu 1

INE) FMOVI Ward M, BT RS &7 O 9T AT o TUTRT 81T (@9 % W) & A aEmes

TN o R UAMWE AT & G A M 3wdta afetn $ebTH, 30 Ethar, T @,
»A Y TR F @u) Aoww) AR w1 g W

ALY

ug-1  Indic 2003 AL ASULL AR @t i,

H3-2  IME o 2y i 240,

W4-3  Indic-Computing Project «il v &g ).

us-4 IMEVS5 56 56 curdly sl shae 20l 9,

U5 Lip o Ay iy osgue,

Us-6 TBIL o 2y -1y avgud),

ua-7 TBiL 15U 5L usR-L s15a R 53 usie d, w2 ueie

ua-8 TBIL i Source Language d¥l3 56 5¢ cunl uis s3Lusl o),

AL vilel - oL

na-1 udslise viglasi 2003 eurdly wtuliﬂ-l AHHR AN D,

Hs-2 IMEVS Ui dgo) eunil Aot 8, ;

un-3  Bl-ewl su-uell »ud 201 921dl, MR8l vin R4l O{L‘;ll‘_tl e o B,
usi-4  TBIL 2 eUiMicR s2dly 15292 D,

w5 TBIL 4i Target Language {13 None i 53 asiy,
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Asn-¢ UB2gsl uRuu

Dilx
9.2

9.3

9.4

95

wRAY

G2 sl H-Ael ﬁLé.Gmﬂi?t '
9.2.1 §-Ae eudl

9.2.2 Adawi aviai Aiadl Rorar dur sl
9.2.3 wauMi Rioraza ysaul dd
UGG 3AwR ddld Gualol
UG2@ sl Gualol il M2

B2l GuuloL U@L 22



9.1  2u62¢s-2003 Al uRAx

AN 8-Aerll naell dell A Afaliols nBULL 541 M2 2UB2es-l GualoL
s U 8. (Bl G2y s i»m@ LRI S-Ae vl vadl §-Ae And) ad
12, Qe s 1A g 523 - gl o2l A 1, v GURIA Il vuuel
21914 AL PAlol] MRl 29Ut 5913 & M) A 21 el 52U D,

Mail Calendar Tasks Messa'ges

Gl Vo T g,
1% Berl Tisnin

U3 Cactet b

L Dralis

1 Oratts
ﬁ’f‘. 1nbox
kg Jurk E:mal
Sk Outbox

B Sent [tems

s e b oS e e

2u4a-1
Mail Contacts Folder List
Calendar Notes
Task

9.2 wuB2ysil S-Ha w2 Gudla

211G2¢sril GulolL §-Ael onatagll 12 el dlatell udel 20U 2uGeesHl  $-a AR
3cf) 0 3RAUMA 522U B A RSY -l I UM 52 H2 Aidl WA §-Ae
wig €ld A2, ULl Gelswl W2 hotmail.com d, §-3a A} Wil asA 3 d
“dhiren_b_patel@hotmail._cor_n” . 9 2443 Tool ->Email Accounts.. /L Y:is
52l Molcll [Rrdlos gl2L 2 $-3e B Rl 59 AR el
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2UH A duid E-mail Accounts.”«{l waigoll sl 112 4418l 241, TR |
.

This wizard will allow you to change the e-mail accounts
and directorles that Dutlook uses:

2 el o
C)yiew or changs existing e-mail accaunts

Directory

(add a new directory or address back
(7 View or change existing directaries or address hooks

: w4(d-3 : Y _
Add a new e-mail account +{l Waiedll sl g §-Ae viig vl w3 %34
MRl AL 20 AnAUHi 1A D, K T g -, g §-Ad vldlg AR-1Y, A4
-2 Wi UUUR Aed AR A el §-Ae Uz M2 Gualatsct A 21 A wal
Fell MRA Anaasl 20d &, A[Eu wnad AU 5 ASH AR, A-l W2 Remem-
ber password A uaie 5141 21Ad U dl AR (e 526 Retae &

E-mail Accounts

G sl |
, §-Re il HUR A 2w yedl qy usel Yol 51 53¢ & ) AR olclaa
o w1 B, '



Congratulations!

You have successfully entered all the information reqUIred ]
seltup your account.

To close the wizard, click Finish,

2u4(d-5
© uls quid B2 sHl - vl MR wiucief] d 9-Re vl HiRell R 53¢
§-Aa- ol (Deleted Items), 2udd $-Aedl vl (Inbox), sseaL Hidldl — §-3a
Yol (Outbox) dall duR 53¢ S-Aanil usll %ﬂséat e‘lq (Send Items) ddl 5le2L A
Ha e,

(o>

i HE Unread Mail

I L2538 For Follow Up

| I Sent Iterns l | 1 .
4 Deleted Iterms E:

ersor‘ual Folders I
) Dlebed s
3 Dirarca !
Ly Irlhw*- |
i L T S ~imall i
N (qwm Ol_n.l.z_r..r
L Sert lesms i
i [ Search rolders i
e | % Fatmall
Tl Deletic) lbm'ns

ﬁ% Tkacss

i DT
Setinl 1=

2u4(d-6
o §-2 QS Wisddlg i AR File Agal w6n New 3 Message +{l wieall
SRl A4 0B (§-0a) @l wsi Q udD D wA 8. ¥ 12 wde 2414 1A B,
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25(d-7

9.2.1 ¢-dd dwdl

& PR O-Ne MR-l Rl dvid) sl I Mol 1 GUR Gleien 1d R
gl wadl 1 ®. 33 e Wsaarrd dg §-Ae A3 To... Hi il sl
vl AU B. IR AN Sl 4R $-Net UUHE GUR s AvL SN Hlsdelisl €1y
QAU €351 §-3e AL To... Wi il avd a2 ; Al ol YsHL 29 . 4rll auid
531 500 5l v st el D e Gul RS sl st 20 8, 2ld
avid GUR ARG §-Net AReML Ce... M aveHi 03§, o dMIR Msedd §- Qar{l
wisat oflon Sl isendl ), Al ol Bell wil hu iR Adl elEiie $-3e wm Bec...
HiQuididi 219 8.

wuld-8
s duid §-Ae AL eruid sul vedlel] §-Neted RNY aviaimi 21 8. §-Yer)

ANy Qv el els[l' gell o3l B, W12 eudl - Aoz uFi Rny Ay udlell
d §-2e vlladd 3 3 A Rl 52 8. Qv Aoy + didl da §-Ae a9 dld) X
(delete) $cll Slanell §-Ae, salr, 51 24l 22 B,
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